Copyright and Disclaimer

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means electronic, mechanical, photocopying, recording, or otherwise without the prior written permission of CyberLink Corporation.

To the extent allowed by law, POWERDIRECTOR IS PROVIDED “AS IS,” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION ANY WARRANTY FOR INFORMATION, SERVICES, OR PRODUCTS PROVIDED THROUGH OR IN CONNECTION WITH POWERDIRECTOR AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, EXPECTATION OF PRIVACY, OR NON-INFRINGEMENT.

BY USING THIS SOFTWARE, YOU AGREE THAT CYBERLINK WILL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, OR CONSEQUENTIAL LOSS ARISING FROM THE USE OF THIS SOFTWARE OR MATERIALS CONTAINED EITHER IN THIS PACKAGE.

The terms and conditions here under shall be governed and construed in accordance with the laws of Taiwan.

PowerDirector is a registered trademark along with other company and product names mentioned in this publication, used for identification purposes and remain the exclusive property of their respective owners.

Manufactured under license from Dolby Laboratories. Dolby, Pro Logic, MLP Lossless, The "AAC" logo, and the double-D symbol are trademarks of Dolby Laboratories. Confidential unpublished works. Copyright 1992-2004 Dolby Laboratories. All rights reserved.

Manufactured under license under U.S. Patent #’s: 5,451,942; 5,956,674; 5,974,380; 5,978,762; 6,226,616; 6,487,535; 7,003,467; 7,212,872 & other U.S. and worldwide patents issued & pending. DTS, DTS Digital Surround, ES, and Neo:6 are registered trademarks and the DTS logos, Symbol and DTS 96/24 are trademarks of DTS, Inc. © 1996-2007 DTS, Inc. All Rights Reserved.

Manufactured under license under U.S. Patent #’s: 5,451,942; 5,956,674; 5,974,380; 5,978,762; 6,226,616; 6,487,535 & other U.S. and worldwide patents issued & pending. DTS is a registered trademark and the DTS logos, Symbol, DTS-HD and DTS-HD Master Audio are trademarks of DTS, Inc. © 1996-2007 DTS, Inc. All Rights Reserved.
International Headquarters

Mailing Address  
CyberLink Corporation  
15F, #100, Minchiuan Road, Shindian City  
Taipei 231, Taiwan

Web Site  
www.cyberlink.com

Telephone  
886-2-8667-1298

Fax  
886-2-8667-1300

Copyright © 2008 CyberLink Corporation. All rights reserved.
# Contents

## Introduction

- Welcome .................................................................................................................... 2
- Latest Features ....................................................................................................... 2
- DirectorZone ......................................................................................................... 4
- PowerDirector Versions ...................................................................................... 4

## The PowerDirector Program

- PowerDirector Modes ......................................................................................... 7
- PowerDirector Projects ..................................................................................... 8

## The Production Process

- System Requirements .......................................................................................... 10

## Pre-production

- Importing Media .................................................................................................... 14
  - Downloading Media .......................................................................................... 14
- Capturing Media .................................................................................................. 17
  - Capture Mode .................................................................................................... 18
  - Capture Options ............................................................................................... 19
  - Capture from DV Camcorder ............................................................................ 20
  - Capture from HDV Camcorder ....................................................................... 21
  - Capture from TV ............................................................................................... 21
  - Capture from Digital TV .................................................................................. 22
  - Capture from PC Camera .................................................................................. 22
  - Capture from Microphone ................................................................................ 22
  - Capture Audio Tracks from CD ....................................................................... 22
  - Capture from a DVD ......................................................................................... 22
- Detecting Scenes and Extracting Audio .............................................................. 23
CyberLink PowerDirector

Detect Scenes in a Video Clip .................................................................23
Extracting Audio from a Video Clip ......................................................24

PowerDirector Preferences ......................................................................25
File Preferences .....................................................................................25
General Preferences ..............................................................................26
Editing Preferences ...............................................................................27
Confirmation Preferences ......................................................................28
Capture Preferences .............................................................................29
Produce Preferences .............................................................................30
DirectorZone Preferences ....................................................................30

Creating Your Story ................................................................. 33

Edit Window Overview ........................................................................34
Set the Project’s Aspect Ratio ............................................................34
The Library Window ............................................................................35
The Workspace ...................................................................................39

Adding Media to Workspace ................................................................43
Magic Movie Wizard ............................................................................43
Slideshow Designer ............................................................................44
Adding Video, Photos and Audio to the Workspace .........................47
Adding Video Effects, Objects, Titles and Transitions .........................49

Preview your Production ....................................................................52
Preview Window ..................................................................................52
Media Viewer .......................................................................................53

Editing Your Media .............................................................................54
Split a Clip .........................................................................................54
Trim a Video or Audio Clip ...............................................................54
Set a Clip’s Duration ..........................................................................55
Mute an Entire Media Clip ..................................................................56
Change the Speed of a Video Clip ......................................................56
Freeze Frame Effect ...........................................................................56
Time Info ............................................................................................57
Set a Video Clip’s Interlacing Format ................................................57
Adjust a Video Clip’s Aspect Ratio ......................................................58
Chapter 1:

Introduction

This chapter introduces CyberLink PowerDirector and the digital video editing process. It provides a discussion of the different kinds of technology you will use in the digital movie-making process, as well as system requirements for working smoothly with CyberLink PowerDirector.

This chapter contains the following sections:

- "Welcome" on page 2
- "The PowerDirector Program" on page 5
- "The Production Process" on page 9
- "System Requirements" on page 10
Welcome

Welcome to the CyberLink family of digital video tools. CyberLink PowerDirector is a digital video editing program that lets you create professional-looking video movies and photo slideshows, complete with music, voice-overs, special effects, transition effects and much more.

If you don't have experience making movies or creating slideshows, don't worry. CyberLink PowerDirector is an easy to use tool that, with just a little practice, will have you making movies like a Hollywood director. In no time you will be creating creative videos and stylish slideshows that you can email to friends, burn to disc to show your family, or upload to the Internet to share with the world.

Latest Features

This section describes the latest features in the CyberLink PowerDirector program.

Library

- Download photos and audio:
  - Search for, download and import media into your Library from Flickr or Freesound directly.
- Manage library tools:
  - Create subfolders within your Media Library to organize your media or save your entire Library as a separate file.
- Download and sharing created media:
  - Share your customized PiP objects and title effects with others by uploading them to DirectorZone. You can also add additional media to your Library by downloading them from the DirectorZone web site.

Edit

- Enhanced Slideshow Designer:
  - Many new slideshow styles to choose from.
• Synchronize photos with the beat of the music and full creative control over the design in cell slideshows.

• Enhanced Magic Tools:
  • Improved lighting in the video with the new Magic Clean functions.
  • Detailed frame controls for picture pan and zoom in Magic Motion.
  • Improved chroma key results.

• Multiple PiP Tracks:
  • The Track Manager lets you add multiple PiP tracks to the timeline, allowing you to display up to six PiP objects on a video at the same time.

• Freeze Frame:
  • Add a freeze frame effect to your video instantly to emphasize a specific frame of video.

• Subtitles:
  • Add subtitles for a disc, which can be switched on/off like those found on commercial discs.

Produce

• Create an HDD Camcorder File:
  • Produce files that can be copied back onto a hard disk drive camcorder.

Create Disc Menus

• Enhanced menu creation:
  • Multi-layered menus and a more easy-to-use and powerful menu designer.

• Download and sharing created disc menus:
  • Share your customized disc menus with others by uploading them to DirectorZone. You can also add additional disc menus by downloading them from the DirectorZone web site.
DirectorZone

DirectorZone is a web service that lets you download PiP objects, title templates and disc menus created by other users of CyberLink PowerDirector. You may also share your own creations by uploading them to DirectorZone.

To sign in to DirectorZone, click the Sign in to DirectorZone link on the top of the CyberLink PowerDirector window.

Go to http://directorzone.cyberlink.com to view more information on the features and benefits of the DirectorZone web site.

PowerDirector Versions

CyberLink PowerDirector is available in many different OEM versions and the full retail version. File format support, editing features, disc-making functions, and other features vary depending on the version that you have. For information on the availability of specific functions in the CyberLink PowerDirector version that you are using, please check the CyberLink PowerDirector Readme file.

Upgrade Your Software

Software upgrades may be periodically available from CyberLink. To upgrade your software, click the Upgrade button on the About CyberLink PowerDirector window. The Upgrade window will open and you can select to download new upgrades and updates for CyberLink PowerDirector. You will be redirected to CyberLink’s cyberstore if you choose to purchase new upgrades.

**Note:** You must be connected to the Internet to use this feature.
The PowerDirector Program

When you first open CyberLink PowerDirector, the program appears as
CyberLink PowerDirector

follows:

**Edit function buttons**
Open editing rooms dedicated to a specific task

**Library window**
Contains your media content as well as various effects, transitions and other media rooms

**Mode buttons**
Click to switch working modes

**Preview window**
Provides playback controls to preview clips and movies

**Magic Tools**
Provide easy ways to work with media clips

**Function buttons**
Shortcuts to common functions

**Workspace**
Insert media clips and effects here
PowerDirector Modes

CyberLink PowerDirector has separate modes that enable you to perform different tasks: Capture, Edit, Produce and Create Disc.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capture</td>
<td>Capture media in a variety of formats, from a variety of sources. See &quot;Capturing Media&quot; on page 17.</td>
</tr>
<tr>
<td>Edit</td>
<td>Edit your production by adding video and photos to the timeline, then add transitions, effects and titles for that creative touch. See &quot;Creating Your Story&quot; on page 33.</td>
</tr>
<tr>
<td>Produce</td>
<td>Produce your creation by outputting it to a file, DV tape or uploading to the Internet. See &quot;Producing Your Movie&quot; on page 83.</td>
</tr>
<tr>
<td>Create Disc</td>
<td>Use Create Disc to create a custom disc, complete with menus, that can be burnt to disc. See &quot;Creating Discs&quot; on page 97.</td>
</tr>
</tbody>
</table>

By default, CyberLink PowerDirector opens in the Edit mode, but you can easily switch between modes to perform your required task by using these buttons.
PowerDirector Projects

Changes you make to your video clips, audio files or photos in CyberLink PowerDirector do not affect your original media. Since your settings are all saved in the project file, you can trim, edit or delete clips in CyberLink PowerDirector, but still keep your original files on your hard drive, untouched. So let yourself get creative! If you end up changing things too drastically, you can always start over.

You can open and save a CyberLink PowerDirector project file just like any other file in Windows. Your projects are saved as .pds files, a unique file format used by the CyberLink PowerDirector program.
The Production Process

The digital production process involves a combination of artistry and technology, beginning with raw footage and ending with your final production. CyberLink PowerDirector is the easiest way to produce your finished movie or photo slideshow and publish it to the medium of your choice.

The production process, depending on your purpose, may involve some or all of the following phases:

• **Pre-production**
  • Importing your media
  • Capturing your media
  • Detecting scenes and extracting audio

• **Putting your story together**
  • Adding your media to the workspace
  • Adding effects, transitions and titles
  • Editing and refining your videos
  • Touching up your photos
  • Using Magic Tools and modifying effects
  • Recording voice overs and mixing audio
  • Setting chapters and adding subtitles

• **Producing and Uploading Your Productions**
  • Producing video files
  • Producing streaming video files
  • Writing back to a DV/HDV tape or create an HDD camcorder file
  • Uploading to the Internet

• **Finalizing production to discs**
  • Creating disc menus
  • Burning your productions to disc
System Requirements

The system requirements listed below are recommended as minimums for general digital video production work.

Screen Resolution:

- 1024 x 768, 16-bit color or higher

OS:

- Windows Vista/XP (Windows XP Service Pack 2 is required for HDV capture)

Memory:

- 512 MB required
- 2GB DDR2 or above recommended for editing HD videos

CPU:

- AVI Capture/Producer: Pentium II 450 MHz or AMD Athlon 500 MHz
- VCD Quality (MPEG-1) Profiles: Pentium III 600 MHz or AMD Athlon 700 MHz
- DVD Quality (MPEG-2) Profiles: Pentium 4 2.2 GHz or AMD Athlon XP 2200+
- High Quality MPEG-4 and Streaming WMV, QuickTime, RealVideo) Profiles: Pentium 4 2.4 Ghz or AMD Athlon XP 2400+
- AVCHD and MPEG-2 HD (for BD/HD burning) Profiles: Pentium Core 2 Duo E6400 or Athlon 64 X2 5000+

Video Capturing Device:

- PCI or USB1.0/2.0 capture device compliant with WDM standard (i.e. PC Camera and TV tuner with WDM driver)
- DV camcorder connected via OHCI-compliant IEEE1394 (check CyberLink web site for supported model list)
- DVD camcorder connected via USB2.0 (check CyberLink web site for supported model list)
- Sony MicroMV/AVCHD/HDV camcorder (check CyberLink web site for supported model list)
Chapter 1: Introduction

- JVC Everio camcorder (check CyberLink web site for supported model list)

**Hard Disk Space:**
- 5 GB required (400MB for SmartSound Quicktrack Library)
- 10 GB (20 GB recommended) required for DVD production
- 60GB (100GB recommended) required for BD/HD/AVCHD production

**Burning Devices:**
- A CD or DVD burner (CD-R/RW, DVD+R/RW or DVD-R/RW) is required to burn VCD/DVD/SVCD/AVCHD titles
- A Blu-ray Disc recordable drive is required to burn Blu-ray Disc titles

**Microphone:**
- A microphone is required for recording voice-overs

*Note:* Please consult the CyberLink web site for the most recent system requirements information. http://www.cyberlink.com/
Chapter 2:

Pre-production

This chapter details the steps required for pre-production, including importing your media into the Media Library, capturing media with CyberLink PowerDirector and setting your CyberLink PowerDirector preferences.

This chapter contains the following sections:

- "Importing Media" on page 14
- "Capturing Media" on page 17
- "Detecting Scenes and Extracting Audio" on page 23
- "PowerDirector Preferences" on page 25
Importing Media

If you already have video files, music and photos on your computer’s hard drive that you want to use in your production you can import them directly into CyberLink PowerDirector’s Media Library.

CyberLink PowerDirector supports the import of the following file formats:

**Image:** JPEG, TIFF, BMP, GIF, PNG

**Video:** DV-AVI, Windows-AVI, DAT, MPEG-1, MPEG-2, DVR-MS, VOB, VRO, WMV, MOV, MOD, TOD, MP4, MTS, M2TS

**Audio:** MP3, WAV, WMA, ASF

When importing media into the **Media Library**, you have two options:

- import media files individually
- import an entire folder that contains media files you want to use in your current project

Downloading Media

If you feel that you do not have enough media for your project or you are looking for specific media to make your creation just perfect, you can now search for, download and then import photos from Flickr or audio from Freesound directly into CyberLink PowerDirector.

**Downloading Photos From Flickr**

You can download your own photos directly from your account on Flickr into CyberLink PowerDirector. You can also search for and browse other users’ photos from within CyberLink PowerDirector, and then import them into your Media Library for use in a project.

To download photos from Flickr, do this:

1. Select **Import from Flickr** from the download menu 🌎.
2. Follow the steps within the wizard window to authorize CyberLink PowerDirector to use your Flickr account and accept the Terms of Use from Flickr.

**Note:** Having a Flickr account is not required to search for, browse and download photos from Flickr.

3. Select from the drop down whether to search for photos from:
   - **My Photos on Flickr:** this option displays thumbnails of all the photos you have uploaded to your Flickr account.
   - **My Contacts' Photos:** this option displays thumbnails of all the photos your Flick contacts have uploaded to Flickr.
   - **Search for Photos on Flickr:** select this option to perform a search for photos on Flickr. You can search for photos by popular search tags 🌟, by user country 🌍 or by keyword 🔍.

**Note:** Use the drop down filter menu at the top of the search window to sort the photos.

4. Select all of the photos that you want to import into your Media Library and then click on the **Download** button.

**Note:** The photos downloaded into your Media Library cannot be used for commercial use. Click on the button underneath the photo thumbnail to view the copyright information.

### Downloading Audio From Freesound

You can download audio samples, such as sound effects or music clips, from the Freesound service into CyberLink PowerDirector.

To download audio clips from Freesound, do this:

1. Select **Import from Freesound** from the download menu 🌍.
2. Follow the steps within the wizard window to sign in to Freesound and then accept the Terms of Use.
3. Within the search window, perform a search for the audio clips you are looking for by popular genres 🌍 or by keyword 🔍.
Note: Use the check boxes to filter the keyword search criteria before performing your search.

4. Select all of the audio that you want to import into your Media Library and then click on the **Download** button.

Note: The audio downloaded into your Media Library cannot be used for commercial use. Click on the button underneath the audio thumbnail to view the copyright information.

**Downloading Templates from DirectorZone**

If you are looking for additional PiP objects or title effects for your library, you can download them from the DirectorZone web site by clicking on 🌐 within the PiP Objects Room and the Title Effects Room.

The additional templates are created by either CyberLink or other CyberLink PowerDirector users, who have uploaded them to DirectorZone.
Capturing Media

CyberLink PowerDirector lets you capture media from a variety of sources directly into your Media Library.
Capture Mode

When you click the **Capture** button you will enter the Capture mode. In Capture mode, the program appears as follows:

- **Capture device selection area**
  Allows you to switch capture devices

- **Captured clips area**
  Displays media clips after capture

- **Capture preview window**
  Displays media clips during capture

- **Information display area**
  Displays information about captured file size and available HDD space

**Note:** Before you begin to capture, make sure your capture environment is set according to your preferred working methods. See "Capture Preferences" on page 29 for more information.
Capture Options

You can capture video clips in the following file formats:

- MPEG-1
- MPEG-2
- MPEG-4
- AVI

Many of the options for capturing are the same for some of the capture modes.

**Note:** CyberLink PowerDirector’s capture functions vary, depending on version installed. For information on the availability of specific features in the version that you are using, please check the Readme file.

Capture Limit Options

You can set limits on the size or duration of the video that CyberLink PowerDirector captures. When the limit you set is reached, the capture will automatically stop.

- To set a maximum capture length, select **Time limit** and then enter a time in the time code box.
- To set a maximum captured file size, select **Size limit** and then enter a size limit (in MB).

To add a text remark, date caption or time code to the captured video, click on .

**Note:** When CyberLink PowerDirector captures content from a RichVideo compliant DV/HDV camcorder, time code information will automatically be captured as well and can be enabled using the Time Info button when the video clip is placed on the timeline. See "Time Info" on page 57 for more information.
To take a still photo of a frame video for use in your project, just click on \[\text{Snapshot}\] at the point where you want to take the snapshot and an image file will be saved to the Media Library.

**Note:** You can specify your preferred snapshot image file format in preferences. See "File Preferences" on page 25 for detailed information.

**Capture from DV Camcorder**

DV camcorders are popular among video hobbyists, as they record in a digital format that does not require conversion before being used on a computer, and often provide a number of advanced recording options. You can capture a single scene or a number of scenes in a batch from your camcorder.

**Note:** If your DV camcorder connects to your computer via USB, you must import video files directly as if your camcorder was another hard drive. See "Importing Media" on page 14 for information on importing video files.

**Capture a Single Scene**

You can capture a single segment of video from your camcorder. This function is particularly useful, for example, if you want to acquire a long video segment in its entirety without skipping over sections.

**DV Backup**

The DV Backup feature \[\text{Backup}\] lets you back-up the digital video from your DV camcorder directly to DVD using CyberLink PowerDirector.

**Note:** This feature requires a DVD burner.

**Batch Capture from a DV Camcorder**

Batch capturing may seem intimidating, but in reality it is an incredibly convenient method of capturing multiple video clips automatically. If you take a few minutes to familiarize yourself with batch capturing, you
will save yourself time when you capture video from your camcorder. CyberLink PowerDirector scans your DV for intervals (or allows you to set them manually), then captures them in a batch using the intervals you created.

**Automatic Batch Capture**

Automatic batch capture is a quick way to capture scenes from a video tape.

**Manual Batch Capture**

Using manual batch capture gives you more control over the capturing process and ensures that the scenes you want to include are captured. Manual batch capturing is recommended when you are sure which scenes you want to capture and have a good idea where they are located on the tape.

**Capture from HDV Camcorder**

HDV camcorders record in a high definition digital format that does not require conversion before being used on a computer, and often provide a number of advanced recording options. You can capture scenes from your HDV camcorder into CyberLink PowerDirector.

**Note:** If your HDV camcorder connects to your computer via USB, you must import video files directly as if your camcorder was another hard drive. See "Importing Media" on page 14 for information on importing video files.

**Capture from TV**

You may wish to add segments from your favorite TV programs to your movie production, or simply record other segments for different uses.
Capture from Digital TV

You may wish to add segments from your favorite Digital TV programs to your movie production, or simply record other segments for different uses.

Capture from PC Camera

PC cameras (also known as web cams) are inexpensive, handy video cameras that you can use for simple video capturing.

Capture from Microphone

Your movie may require recorded dialog. No matter what kind of audio tracks you record, they can be captured with a microphone for use in your CyberLink PowerDirector project.

Capture Audio Tracks from CD

Using your favorite music can help you to create a really fun, personalized movie. If you have music stored on an audio CD, you can record songs you want and then add them as audio tracks in your CyberLink PowerDirector project.

Capture from a DVD

You can capture video scenes (including the audio portion) from a DVD for use in your CyberLink PowerDirector project.

Note: Some DVDs are protected by technology that does not allow you to capture the content they contain.
Detecting Scenes and Extracting Audio

To assist with your editing process, CyberLink PowerDirector can detect scenes in your video clips or extract the audio from them, and have these new clips displayed separately in the Media Library.

Detect Scenes in a Video Clip

The scene detection function automatically creates individual clips based on the individual scenes (or pre-edited shots) contained within a video clip. Detected scenes are not split from the original clip, but can be added to the workspace like any other media clip. Likewise, they may also be merged together or removed entirely without changing the original video clip. You can detect scenes in a video clip in both the Captured Clips area or within the Media Library.

**Note:** Depending on the file format, scene detection on certain clips may not work as precisely as it does for others. You may need to split the scenes manually in the scene detection dialog.

The detected clips are displayed in a sub folder under the original video clip. They can be added to the workspace and managed in the Media Library like any other video clip.

Video clips that contain detected scenes show a small folder icon in the lower right-hand corner of the clip when displayed in the Media Library. To display a clip's scenes, click the folder icon.
Extracting Audio from a Video Clip

If you want to include just the audio from a video clip, you can extract it from the video clip in the Media Library by right clicking it and selecting Extract Audio. The audio clip will be separated from the video and can be used in your project like any other audio file.
Chapter 2: Pre-production

PowerDirector Preferences

CyberLink PowerDirector offers a range of choices to set your video production environment to better suit the way you work. Before you get started working on your production you may want to set your preferences to your liking. You may also edit them at any time during the production process to accommodate your needs.

File Preferences

To set your file preferences, click Edit > Preferences. The Preferences dialog box opens, displaying the File tab. Available options are as follows:

- **Import directory**: indicates the last folder that media was imported from into CyberLink PowerDirector. To change this folder, click Browse and select a new folder.
- **Export directory**: set the folder where CyberLink PowerDirector saves captured media files by default. To change this folder, click Browse and select a new folder.
- **Captured video prefix**: enter a default name for captured video files. CyberLink PowerDirector automatically appends a sequential number to this name to create a unique filename for each captured file.
- **Always prompt me to confirm filename**: Check this option if you would like CyberLink PowerDirector to prompt you to enter a filename each time you capture a video clip.
- **Production file prefix**: enter a default name for files produced in CyberLink PowerDirector.
- **Snapshot filename**: enter a default name for snapshot captures. CyberLink PowerDirector automatically appends a sequential number to this name to create a unique filename for each captured file. Select a file format from the drop-down list for your snapshots. You have the choice between .bmp, .jpg, .gif and .png formats.
• **Always prompt me to confirm filename**: select this option if you would like CyberLink PowerDirector to prompt you to enter a filename each time you take a snapshot.

• **Snapshot destination**: select a destination for snapshot captures from the drop-down list if you don’t want to save them as a file.

• **Use master video size whenever possible**: select this to have the snapshot be the same size as the original video, instead of the smaller preview window it was taken in.

• **Number of recently used project(s)**: enter a number (between 0 and 20) of recently used projects that you would like to make available in the File menu when you open CyberLink PowerDirector.

• **Automatically load the last project when PowerDirector opens**: select this option to automatically load the project you have been working on most recently whenever you open CyberLink PowerDirector.

• **Automatically load sample clips when PowerDirector opens**: select this option for CyberLink PowerDirector to load sample video files and photos into the Media Library when opened.

### General Preferences

To set your general preferences, click ![ ] > **Edit** > **Preferences**. The Preferences dialog box opens. Click the **General** tab. Available options are as follows:

• **Maximum undo levels**: enter the number (between 0 and 100) of undos (Ctrl+Z) you would like to make available while you work on your movie production. Setting a higher number consumes more CPU resources.

• **TV format**: select the TV format (NTSC or PAL) of the region in which you would like to produce your movie. This format should correspond to the format of the region in which you plan to play your movie (if you burn it to disc).
Chapter 2: Pre-production

- **Enable animated Interface**: select to enable the animated interface within CyberLink PowerDirector.
- **Show sound waveform in Timeline**: select to display the sound waveform in the timeline that represents the sound levels in the audio portion of video clips, music clips and voice clips.
- **Enable file processing to speed up high definition video editing**: select this to speed up the editing of high definition video by enabling CyberLink PowerDirector to process the file faster. Enabling this consumes more CPU resources.
- **Enable appending of information into files as RichVideo information**: select to allow CyberLink PowerDirector to append RichVideo information into the media files.
- **Enable the RichVideo information in open media dialog**: select to have CyberLink PowerDirector display RichVideo information when importing media into the Media Library.
- **Automatically check for software updates**: select to have CyberLink PowerDirector periodically check for updates or new versions automatically.
- **Use system default language**: select this option for the CyberLink PowerDirector language display to be the same as the language of your operating system.
- **User defined**: select this option and then select the language from the drop-down list that you want CyberLink PowerDirector to use.

**Editing Preferences**

To set your editing preferences, click 🌐 > Edit > Preferences. The Preferences dialog box opens. Click the **Editing** tab. Available options are as follows:

- **Default workspace**: select whether to display the Timeline or Storyboard workspace in CyberLink PowerDirector by default.
- **Link all tracks when moving/removing content in Video track**: links titles, video effects, music and PiP clips to clips in the Master Video track. Selecting this option moves these clips when a video
clip in the Master Video track is moved. Uncheck this option to allow for the movement of all Timeline clips separately.

- **Add transition between photos when applying Magic Motion:** select this option to add a transition effect between adjacent photos when you use the Magic Motion tool and apply to all photos.
- **Add an effect and a title when using Freeze Frame:** select this option to have CyberLink PowerDirector automatically add an effect and title to the timeline when you click the Freeze Frame button.
- **Durations:** set the default durations (in seconds) for image files and the different effects in the timeline.
- **Auto Save Project:** select this to have CyberLink PowerDirector auto save your project. You can enter a specific time in the field provided. This ensures you don’t lose your changes if there was a power outage or your computer crashed and you forgot to save your creation.

## Confirmation Preferences

To set your confirmation preferences, click > Edit > Preferences. The Preferences dialog box opens. Click the **Confirmation** tab. Available options are as follows:

- **Always prompt me when TV format conflicts:** select this option to enable a warning message when you add a video clip to the workspace whose TV format (NTSC/PAL) conflicts with that of the video clips already located in the workspace.
- **Enable file deletion from hard drive:** select this option if you would like to enable the deletion of files from your hard drive from within the Media Library.
- **Enable warning when chapters are removed during editing:** select this option to enable the display of a warning message if chapter points have been deleted during video editing.
Always prompt me when wide screen is not supported: select this option if you would like CyberLink PowerDirector to prompt you when the widescreen format is not supported.

Capture Preferences

To set your capture preferences, click > Edit > Preferences. The Preferences dialog box opens. Click the Capture tab. Available options are as follows:

- **Add captured files to Library**: select this option to import captured files into the Media Library directly after capture.
- **Add captured files to workspace**: select this option to import captured files into the workspace/timeline directly after capture.
- **Use video overlay for capture**: keep this option selected during capture unless you have an older VGA card that does not support video overlay. (Deselecting this option in this event avoids the unsupported overlay display error.)
- **Enable automatic file replacement when recording voice-over**: select this option to overwrite existing audio if the voice-over overlaps during recording.
- **Enable CyberLink MPEG@Best**: select to balance capture speed and video quality when you capture MPEG video.
- **Do not detect scenes during capture**: select this option if you do not want to activate the auto scene detection function during capture.
- **After capture, detect scenes by changing of video frames**: select this option to perform scene detection during video capture. In scene detection, CyberLink PowerDirector compares captured frames to decide when there is a scene change. Each scene is saved as a file as recording continues.
- **During capture, detect scenes by time code, and save each scene as a separate file (DV-VCR mode only)**: select this option to detect scene-break signals and to save each scene as a separate file. (DV camcorder generate a scene-break signal on
the tape whenever users release the REC button.) This feature is only available in DV camcorder capture.

- **DV Parameters**: click this button to set the buffer parameters for your DV camcorder. Setting a buffer time ensures that your DV camcorder and your batch capture or DV writing device begin at the same time. Without a buffer, batch capturing or writing to tape may begin before the camcorder is engaged.

**Produce Preferences**

To set your production preferences, click ➤ Edit > Preferences. The Preferences dialog box opens. Click the **Produce** tab. The available options are as follows:

- **Output only selected tracks**: select this option to output only the selected tracks in the timeline. The tracks that are not selected will not be produced.
- **Quality of 3D slideshow**: use the slider to determine the quality of a produced 3D slideshow video. The slower the images move, the better the quality of the slideshow. CyberLink PowerDirector will use your computer’s 3D graphics card to accelerate the production time, if there is one in your system.

**DirectorZone Preferences**

To set your production preferences, click ➤ Edit > Preferences. The Preferences dialog box opens. Click the **DirectorZone** tab. The available options are as follows:

- **Auto sign in to DirectorZone when PowerDirector is launched**: select this option and then enter in your email address and password to have CyberLink PowerDirector automatically sign in to DirectorZone when the program is opened. If you do not have a DirectorZone account, click on the **Get an Account** button.
• **Allow DirectorZone to gather editing information**: select this option to allow DirectorZone to collect all of the names of the templates used in a finished project that is being uploaded to YouTube.
CyberLink PowerDirector
Chapter 3:

Creating Your Story

Now that you have all of your video, photos and audio ready, this chapter will guide you through the process of turning your collection of media into professional-looking video movies and photo slideshows. It also describes how to view project information and to preview your movie during production.

This chapter contains the following sections:

- "Edit Window Overview" on page 34
- "Adding Media to Workspace" on page 43
- "Preview your Production" on page 52
- "Editing Your Media" on page 54
- "Using Magic Tools" on page 59
- "Modifying Effects" on page 63
- "Audio Mixing and Voice Overs" on page 73
- "Chapters" on page 79
- "Subtitles" on page 80
Edit Window Overview

Before you get started with the editing process, it is important that you become familiar with the Edit window. This section provides you with an overview of some of its key features and functions.

Set the Project’s Aspect Ratio

Before you start working on your project, you should set your movie’s aspect ratio. The default aspect ratio is 4:3, but if you want your production to utilize a widescreen TV you may change the aspect ratio to 16:9, provided that the media clips you have are also in widescreen format. To modify the aspect ratio for your media, see "Adjust a Video Clip’s Aspect Ratio" on page 58.

To set the aspect ratio for your project, click \( \text{Edit} \) > Aspect Ratio > 4:3 or 16:9. The preview window will change according to the aspect ratio you have chosen.

Note: It is important that you set the aspect ratio of your movie before you start adding clips to the timeline/storyboard. You will need to restart your project if you change the aspect ratio of your project later.
The Library Window

The Library window contains all of the media in CyberLink PowerDirector, including your video, photos and music files and the effects and additions you apply to your media. The media content that is displayed in the Library window is dependent on the room you select.

The Library window is displayed as follows:
To switch rooms and the content that is displayed in the Library, use the buttons on the left side of the window. These buttons are displayed below:

![Diagram of buttons]

Each of these buttons opens a room and displays a corresponding library of media, effects or access to controls for mixing audio, adding chapters or subtitles. By default, the Library opens to the Media Room. However, the Library retains the same buttons and functions in each of these views.

**Media Room**

The Media Room contains access to the storage area, or library, of the media that you can use in your project. The type of media clips that appear in the Media Room depend on the selection you make in the Filter drop-down list.
Managing the Media Room Library

Use the Manage library button  to manage the media within your library. You can:

- Organize your media into subfolders.
- Save the media in your library to a file, that can later be imported.
- Clear all the contents of your library.

Effect Room

The Effect Room contains a library of special effects that can be applied to video or image clips in your project. For more information, see "Adding Video Effects" on page 49.

PiP Objects Room

The PiP Objects Room contains a library of graphics that you can add on the video or photo clip in the PiP Track. There are three main types of objects:

- static graphics
- motion graphics that fly through the clip
- decorative borders that can be added to frame your clip

Inserted objects are displayed in the PiP Track and can be modified in the PiP Designer. For more information, see "Modifying Objects" on page 63.

Title Room

The Title Room contains the library of titles that can be applied to your project to add credits or comments to your production. For more information, see "Adding Title Effects" on page 50.
Transition Room

The Transition Room is a library of transitions that can be applied between video or image clips in your project, helping to make edits appear smoother and more professional. For more information, see "Adding Transitions" on page 51.

Audio Mixing Room

The Audio Mixing Room contains audio mixing controls for all of the audio tracks in your project. For more information, see "Mix Audio Levels in the Audio Mixing Room" on page 74.

Voice-Over Recording Room

The Voice-Over Recording Room contains controls for recording a narration from a microphone while watching the video clip the voice-over is to accompany. For more information, see "Record a Voice-Over" on page 76.

Chapter Room

The Chapter Room contains options for automatically or manually setting chapter markers. Setting chapters on your final disc allows viewers to jump from the menu page to the chapter markers you have set in order to navigate around your disc. For more information, see "Chapters" on page 79.

Subtitle Room

The Subtitle Room lets you add subtitles to your production manually or through the import of a .TXT or .SRT file directly into CyberLink PowerDirector. For more information, see "Subtitles" on page 80.
The Workspace

The workspace is the section of the Edit window where you create your project by adding media clips, effects, transitions, etc. The workspace has two different views, the Timeline and Storyboard view, which can be accessed by clicking on the Timeline or Storyboard buttons.

**Note:** You can set which workspace view is displayed by default in "Editing Preferences" on page 27.

You load media and effect clips into specific tracks in the workspace, move them to different locations in your story, or remove them from the workspace. This section describes how to add clips to the proper track and how to manage clips once they have been added.

Timeline View

The Timeline view lets you view your entire project based on running time. This view is useful when wanting to insert effects, subtitles, etc. at a specific moment or time. The Timeline view also provides a view of various tracks and where they appear in the timeline. To switch to Timeline view, click .
### Media Tracks

The Timeline contains the following tracks:

<table>
<thead>
<tr>
<th>Track</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master Video Track</td>
<td>contains your project’s main video and/or image clips.</td>
</tr>
<tr>
<td>Effect Track</td>
<td>contains special effects that apply to the video or image clip in the Master Video Track at the same location.</td>
</tr>
<tr>
<td>PiP Track</td>
<td>contains video/image clips and objects that are inserted over any clip in the Master Video Track that appear during the PiP effect’s duration. Within the Track Manager you can add up to six PiP tracks into the timeline. The PiP tracks will then be numbered within the timeline accordingly.</td>
</tr>
<tr>
<td>Title Track</td>
<td>contains title effects that appear over any clips in the Master Video Track that occur during the title effect’s duration.</td>
</tr>
<tr>
<td>Voice Track</td>
<td>contains a narrative voice-over or second audio clip.</td>
</tr>
<tr>
<td>Music Track</td>
<td>contains your project’s main audio and music clips.</td>
</tr>
</tbody>
</table>

### Track Manager

Within the Track Manager you can add PiP tracks to the timeline, allowing you to have up to six PiP objects displayed on a video at the same time. To add PiP tracks to the timeline, click on and then select the number of PiP tracks you would like add.

After you have added additional PiP tracks to the timeline, click on the Fit timeline button to have all of the tracks be dynamically displayed within the existing timeline, so you don’t need to scroll to view certain tracks.
Chapter 3: Creating Your Story

Locking/Unlocking Tracks in the Timeline

To lock a track in the Timeline, click at the left of the track. When a track is locked, you cannot add new clips to the track, nor move or edit the clips it contains. To unlock a track in the Timeline, click at the extreme left of the track. When a track is unlocked, you can freely add, move and edit clips. For more information, see "Preview your Production" on page 52.

Showing/Hiding Tracks in the Timeline

To hide a track in the Timeline, first click Movie in the Preview window, then click at the extreme left of the track. When a track is hidden, it will not be displayed in the Preview window. This way you can preview your project by tracks and concentrate on the track you are working on.

To display a track that has been hidden in the Timeline, first click Movie in the Preview window, then click at the extreme left of the track.

Resizing the Ruler

You can resize the ruler for a more expanded or more condensed view of your production. To resize the ruler, click inside the ruler and drag.

Expand the ruler for more a precise view, which is especially handy when aligning clips and effects, or condense the ruler for a global overview of your entire production.

Timeline Zoom

You can change your overall view of the timeline by zooming in or out, allowing you to quickly view the entire contents of your movie production in the timeline. To zoom in or out, use the slider located at the bottom of the timeline.
Storyboard View

The Storyboard view is essentially a large graphical display of your project. The Storyboard view is useful to assist you visualize the scenes and the overall production. To switch to storyboard view, click.

Note: A number of features are unavailable in the Storyboard view. If you try and perform a function that is not available in this view, CyberLink PowerDirector automatically switches to the Timeline view.
Adding Media to Workspace

Now you can begin putting your final production together by adding media and effects to the workspace. You can also use the Magic Movie Wizard or the Slideshow Designer to quickly create a production if you are short on time or to use as a guideline to get you started.

Certain media clips may only be added to specific tracks, for example titles to the Title Track, transitions to the Transition Track, or audio to the Voice or Music Track. When you select a media clip, the tracks that it can be added light up.

Magic Movie Wizard

If you are new to the editing process and not sure how or where to get started, then the Magic Movie Wizard can help. The Magic Movie Wizard can take all of your media and create a dazzling movie production in just a few steps. The created production can then be edited and refined in the workspace, outputted to a file or burned to disc.

Note: The Magic Movie Wizard provides the option of using all the media in the Media Library, all the media currently in the workspace or all currently selected media. If you only want to use a specific number of clips, select the clips you want to use before you begin.
The Slideshow Designer is the easiest way to take your photos and turn them into dynamic slideshows. Drag all the photos that you want in the slideshow into the timeline, make sure they are selected and then click on the Slideshow button to launch the Slideshow Designer.

Within the Slideshow Designer you can select from a number of slideshow templates to apply to your photos. Each template will create a completely different type of slideshow. Click Next to go to the Preview window and see the outputted result. You can then return to the previous window and select another template if you like.

- To add background music, click + and then select the audio file that you want to use.

**Note:** If you select to include background music with your slideshow, CyberLink PowerDirector uses the Magic Slideshow technology to synchronize the photos along to the beat of the music during the slideshow.
Music Settings

If you are using background music in your slideshow, click on **Music Settings** to configure the music settings for your slideshow as follows:

- if required, trim the audio file using the playback controls and then move the sliders on the trim bar to the desired start and end points.
- if required, during playback of the background music, click to mark the starting point of the music and then to mark the end point.
- if required, select to have the background music gradually Fade-in or Fade-out.

Slideshow Settings

Click on **Slideshow Settings** to configure the slideshow settings for your slideshow as follows:

- **Duration**: use this feature to set the length of your slideshow. Select **Fit photos to music** to have the length of the slideshow match the duration of the selected music. Select **Fit music to photos** to have the slideshow match the current length in the timeline, resulting in the music being shortened to match.
- **Sequence**: use this feature to set the photo sequence for your slideshow. Select **Timeline order** to have the sequence match the order the photos are currently displayed in the timeline. Select **Date/time taken** to have the photos in your slideshow be in chronological order based on the date and time the photos were taken.
Advanced Cell Slideshow Settings

If you selected the Cell slideshow template, you can click on the Advanced button within the preview window to manually edit your slideshow if required.

Within the Advanced Window you can perform the following functions:

- Use the playback controls to preview the slideshow.
- Click the Remix button to have CyberLink PowerDirector generate a new version of the cell slideshow.
- Click on Add Photo to add additional photos to your cell slideshow.
- Drag a photo in the Preview area pane to an alternative cell, if required.
- Drag and drop the photos from the Unused photos pane to the cell where you want it located.
• Select a photo and then click on the **Set focus area** button to indicate what portion of a photo you want to be the focus in a photo cell.
• Indicate the maximum number of photos that can be displayed on a slide.

## Adding Video, Photos and Audio to the Workspace

The sections below describe the procedures for adding each kind of media clip into the workspace.

**Note:** You may prefer to add clips in Storyboard view, since this view is simpler than the Timeline view. However, clips can only be added to the Video track in this view. Therefore, this section uses the Timeline view in all of the procedures.

### Add Video Clips & Photos

You can add video clips and photos to either the Master Video Track or a PiP (picture-in-picture) Track.

**Note:** You can add additional PiP tracks to your project’s timeline in the Track Manager, allowing you to have up to six PiP objects displayed on a video at the same time. See "Track Manager" on page 40 for more information.

To add video clips or photos to the workspace, you can:

- Click ![Video Track](image) to add the clip to the Video Track or ![PiP Track](image) to add the clip to a PiP Track.
- Drag clips to a desired position in the Video or a PiP Track. When adding clips to the Master Video Track, you cannot leave an empty gap between adjacent clips. Clips added to the end of the Master Video Track follow immediately after the final clip in that track.
Note: You may select several clips and drag them together into the same track, provided all of the clips are compatible with the destination track.

- Right-click on a clip and select Add to Video Track or Add to PiP Track as required.

To create the basic framework of your movie, add video clips and photos to the Master Video Track. Add media to a PiP track only to create a picture-in-picture effect.

Note: Use the PiP Designer to customize the PiP effects in your movie production. See “Modifying a PiP Effect or Object” on page 64 for more information.

Add Color Boards

The use of color boards allows you to insert solid frames of color into your movie. Color boards are really useful as quick transitions between video clips or as background for titles and ending credits.

Note: You can add color boards to either the Master Video or PiP Track.

Add Audio Clips

Using audio clips allows you to add background music or a narrative voice-over to your movie. CyberLink PowerDirector provides two tracks for audio media (the Music and Voice Tracks), which you can use interchangeably.

To add video clips or photos to the workspace, you can:

- Click 🎵‍ ‍️ to add the audio clip to the Voice Track or 🎵‍ ‍️ to add the audio clip to the Music Track.
- Drag one or more audio clips to a desired position in the Voice or Music Track. Audio clips can be added at any point in this track.
- Right-click on a clip and select Add to Voice Track or Add to Music Track as required.
Chapter 3: Creating Your Story

Note: Audio files can only be added to the workspace in Timeline view. If you drag an audio file to the workspace in Storyboard view, the workspace automatically switches to Timeline view.

Adding Video Effects, Objects, Titles and Transitions

The sections below describe the procedures for adding video effects, objects, titles and transitions into the workspace.

Note: Video effects, objects, titles and transitions can only be added to the workspace in Timeline view. If you drag one of these to the workspace in Storyboard view, the workspace automatically switches to Timeline view.

Adding Video Effects

To add a video effect to a portion of a clip in the Timeline, you can:

- Click to add the effect to the Effect track at the current position of the Timeline slider.
- Drag an effect from the Effects Room into the Effect Track directly beneath the clip(s) in the Master Video Track that you want to apply it to.
- Right-click on an effect and select Add/Replace in Timeline to add or replace the Effect track at the current position of the Timeline slider as required.
- You can add a random video effect at the current position of the Timeline slider by clicking and then selecting Add Random Video Effect.

Note: Click the Modify button to edit the effect’s options. See "Modifying a Video Effect" on page 63.

To add a video effect to an entire clip in the Timeline, you can:
CyberLink PowerDirector

- Select an effect, drag it to the Master Video Track and then drop it on top of the clip you want to apply it to. The video effect will be applied to the entire duration of the clip.

  **Note:** Click the **Effect** button to edit the effect’s options. See "Modifying a Video Effect" on page 63 for more information.

### Adding PiP Objects

To add a PiP object to the Timeline, you can:

  **Note:** You can add additional PiP tracks to your project’s timeline in the Track Manager, allowing you to have up to six PiP objects displayed on a video at the same time. See "Track Manager" on page 40 for more information.

- Drag an object from the PiP Objects Room into the desired position in the PiP track.
- Right-click on an object and select **Add/Replace in Timeline** to add or replace the object at the current position of the Timeline slider as required.

  **Note:** You can download additional PiP objects from the DirectorZone website. See "Downloading Templates from DirectorZone" on page 16 for more information.

Once you have added your objects to the PiP track, click the **Modify** button to edit the objects placement, motion and more in the PiP Designer. See "Modifying a PiP Effect or Object" on page 64 for more information.

### Adding Title Effects

To add a title effect to the Timeline, you can:

- Click the **Title** button located below the Library to add the effect to the Title Track at the current position of the Timeline slider.
- Drag an effect from the Title Room into the desired position in the Title Track.
• You can add a random title effect at the current position of the Timeline slider by clicking and then selecting **Add Random Title Effect**.

  **Note:** You can download additional title templates from the DirectorZone web site. See "Download Templates from DirectorZone" on page 16 for more information.

You can edit the title effect in the Title Designer that opens. See "Modify a Title Effect" on page 68 for more information.

**Adding Transitions**

To add a transition to the Timeline, you can:

• Select a transition effect and then drag it from the Transition Room to between the clips in the Master Video track where you want it to be applied.

  **Note:** You can set the transition's duration. See "Set a Clip's Duration" on page 55 for more information.

To add random transitions to **all clips** in the Timeline, you can:

• Click on a transition and then on the button located below the Library to add a random transition to all clips in the timeline.

• Click on a transition and then on the button located below the Library to add a random fading transition to all clips in the timeline.

• Click on in the library window and selecting **Apply Random Transition Effect to All** or **Apply Fading Transition to All**.
Preview your Production

While you are creating your video production, you will be constantly viewing your production to ensure it is what you want. CyberLink PowerDirector offers two preview methods for viewing your production. You can choose to view a particular clip or view the entire movie production.

Preview Window

The easiest way to preview a media is by playing it in the preview window to the right of the Library. Any media clip that appears in the Library or the workspace can be previewed in this window. However, playback controls are only available for video and audio media.
Media Viewer

The Media Viewer is similar to the preview window, but offers you a larger preview picture than the preview window.

To launch the Media Viewer, click in the preview window.

The Media Viewer allows you to preview media clips as well as your entire movie production in a large, resizable window.
Editing Your Media

Once you have your media in the workspace you can perform edits and refinements to it. Editing is a broad term that encompasses a number of different functions: you can, for example, trim unwanted sections from video or audio clips, increase or decrease the speed of a video clip, or touch up your photos. This section describes all of the editing processes that you can perform on the different types of media clips.

Note: The functions in this section can only be performed in Timeline view.

Split a Clip

You can split a media clip into two clips at the current position of the Timeline slider. The procedure is the same for any type of clip (video, photo, audio or effect) except for transitions.

Note: Splitting a video or audio clip does not delete any portion of the content. Both halves of a split video or audio clip can be stretched back to any length up to the original duration.

Trim a Video or Audio Clip

Video clips captured from external capture devices often contain unwanted portions at the beginning, between the scenes you want or at the end. These unwanted portions can easily be removed in CyberLink PowerDirector using the Trim function.

Likewise, if you want to tailor your audio clip to fit the duration of a video clip, you can easily trim your audio clip to a desired length.

Note: Trimming a video or audio clip does not delete any portion of the content.

You can perform either a simple trim or a multiple trim. Multiple trim allows you to trim several portions from a video clip, resulting in individual clips, which are independent of the original clip. You can also
detect scenes using the Multi Trim tool. Detected scenes, by contrast, are not split from the original clip, but are simply divisions contained within it.

- To perform a simple trim a video or audio clip, select the clip you want to modify and click **Trim**.
- To perform a multiple trim a video or audio clip, select the clip you want to modify and click **Multi Trim**.

**Note:** To make a more precise cut, click 📸 to open the timeline magnifier and use the zoom in ✂️ button or zoom out 📸.

## Set a Clip’s Duration

Within the timeline you can set the amount of time:

- a single photo clip is displayed
- a title effect is displayed
- a video effect is applied to the Master Video track
- a PiP effect or object is displayed
- a transition takes to complete

To set a clip’s duration, do one of the following:

- select the clip, click the Duration button, enter the new duration in the Duration Settings window and then click ok.
- right click on the clip, select **Set Duration**, enter the new duration in the Duration Settings window and then click ok.
- select the clip, position your cursor at one end of the it and then drag the end of the clip to the new position.

**Note:** Transitions can only be lengthened to half of the duration of the shortest clip they affect.
**Mute an Entire Media Clip**

You may wish to mute the audio output of an entire media clip. To do this, right-click the clip and select **Mute Clip**. Any audio volume keys you have added are hidden.

To restore sound to the track, right-click the track and uncheck **Mute Clip**. The audio volume keys you have added are restored.

**Change the Speed of a Video Clip**

Slow-motion or fast-motion effects can grab your audience’s attention as well as break up the rhythm of a movie.

To change the speed of a video clip, select the clip you want to modify and then click **Speed**.

**Note:** Clips with stretched audio can be slowed down to 0.50 X the original speed or sped up to 2.0 X the original speed. Clips with muted audio can be slowed down to 0.10 X the original speed or sped up to 10 X the original speed.

**Freeze Frame Effect**

You can add a freeze frame effect to your video files instantly with the **Freeze Frame** button.

By selecting a specific moment within your video and then clicking on **Freeze Frame**, CyberLink PowerDirector will take a snapshot of the
frame of video and insert it into the timeline. It will also insert a video effect and title template, to enhance the freeze frame effect during video playback. Be sure to edit the inserted photo and effects to your specification to ensure the freeze frame effect fits your creation.

You can choose to not have CyberLink PowerDirector insert the effects by deselecting the option in preferences. See "Editing Preferences" on page 27 for more information.

**Time Info**

When a RichVideo video clip or an EXIF image is added to the timeline, the **Time Info** button will be enabled. Click the **Time Info** button to enable the date caption or time code that was captured from the original camcorder or digital camera. You may also add a text remark to your video or image if required.

**Set a Video Clip’s Interlacing Format**

All video clips have an interlacing (TV) format, which specifies how frames are displayed. Using video clips with conflicting (or incorrect) TV formats can result in degraded video quality in your final production.

Before you produce your movie, set all of the video clips to the same format. While CyberLink PowerDirector can normally detect and suggest the correct format, some interlaced video (such as a video with very little motion) may be misjudged as a progressive video.

CyberLink PowerDirector automatically produces interlaced video for DVD, SVCD and DV-AVI. Only change this setting if you are sure that CyberLink PowerDirector has wrongly set the format.

*Note:* This is an extremely important step to take before production, as it can drastically affect final video quality.

To set a video clip’s TV format, right-click the video clip whose interlacing format you want to set and select **Set TV format**.
Adjust a Video Clip’s Aspect Ratio

Video clips usually come in one of two aspect ratios, 4:3 or 16:9. Depending on your media clips and the medium you will be using to view your movie, you can adjust your movie’s aspect ratio accordingly. Before you produce your movie, set the aspect ratio for all of the video clips so that it matches the aspect ratio of your project.

Depending on the aspect ratio of your project and the aspect ratio of your clips, you have two options to choose from.

If your project aspect ratio is 4:3 and you wish to produce movies with clips of 16:9 aspect ratio, right-click on the video clip you want to adjust and select Set Aspect Ratio.
Using Magic Tools

CyberLink PowerDirector offers a number of magic tools that can assist you to edit and touch up your audio, video and image clips. The magic tools can also help you add a creative style to your movie production or add the right background music. CyberLink PowerDirector offers the following Magic Tools:

- **Magic Movie Wizard**: Magically creates an edited movie blended with stylish effects and transitions.
- **Magic Clean**: Cleans audio, video and image clips.
- **Magic Motion**: Adds zooms and pans to image clips.
- **Magic Cut**: Automatically condenses long video segments into shorter clips that contain only the best moments.
- **Magic Fix**: Fixes shaking videos, removes red-eyes and enhances the focus on photos.
- **Magic Style**: Creates professional movies with pre-designed style templates automatically.
- **Magic Music**: Adds background music that automatically adjusts to suit different durations.
Magic Movie Wizard

If you are new to the editing process and not sure how or where to get started, then the Magic Movie Wizard can help. The Magic Movie Wizard can take all of your media and create a dazzling movie production in just a few steps. The created production can then be edited and refined in the workspace, outputted to a file or burned to disc. See "Magic Movie Wizard" on page 43 for detailed information on using this feature.

Magic Clean

CyberLink PowerDirector’s Magic Clean tool can be used to clean up image files, video files, as well as audio files. The Magic Clean tool can help revitalize your project by making your media clips cleaner, sharper, and brighter and your audio files crisper and clearer. You can now apply color and light adjustments and modify the white balance at the same time.

Magic Motion

CyberLink PowerDirector’s Magic Motion tool adds zooms or pans to an image clip, creating a motion effect in your final movie. The Magic Motion tool is ideal for turning slideshows into engaging presentations, especially when combined with Magic Music. Select from a number of motion templates for each photo in your project and use the Magic Motion Designer to customize the motion to your liking.

Magic Motion Designer

After you select a motion template to apply to the selected photo, select Motion Designer to customize the motion within the photo. See the descriptions for modifying motion, rotation and speed for PiP.
objects within "Adding PiP Objects" on page 50 for detailed information on modifying the motion.

**Magic Cut**

You can fit a video clip to a specific time by automatically cutting out unnecessary portions and keeping only the best moments. The Magic Cut feature uses “magic” video technology to locate and keep the most interesting moments, while discarding sections of lesser importance. The Magic Cut tool is ideal for condensing long video segments into shorter clips - for example, cutting one hour of video down to ten minutes.

*Note:* If the video segment you are using is shorter than 15 minutes in length, has been previously edited, or contains extremely important moments, you may prefer to edit it manually - for example, by using the Multi Trim function. See "Trim a Video or Audio Clip" on page 54.

**Magic Fix**

Magic Fix can stabilize videos taken with shaky hands. You can increase or decrease the level of correction, depending on the severity of the shaking. Magic Fix also can automatically remove red-eye and enhance the focus on photos that are out of focus.

**Magic Style**

Magic Style creates professional movies with pre-designed style templates automatically. Magic Style includes pre-designed opening sequences, transitions and effects to automatically generate professional-looking movies on your timeline. It is perfect for use when you want to create great
looking movies without the hassle of setting up the opening title, video effects and transitions yourself.

**Note:** Magic Style Templates can be expanded through Online purchases. Please see "Upgrade Your Software" on page 4 for more details.

**Magic Music**

Magic Music automatically adjusts the playback of the music clips it contains to fit any length from 5 seconds to 2 hours, and fine-tunes the audio for a smooth cut-off. The Magic Music tool is ideal for use with photo slide shows.

**Note:** Click the **SmartSound** button to view SmartSound-related copyright and purchasing information.
Modifying Effects

Most effects have a number of options that you can set individually to increase or decrease the intensity of the effect, or to achieve more creative results. In fact, this section describes some of the most creative functions found within the CyberLink PowerDirector program. Mastering the procedures found in this section will go a long way towards making you a digital video editing expert!

Modifying a Video Effect

Video effects are applied to the Effect Track at the time position of the video or image clip(s) that you want to affect. Video effects only affect the clips in the Master Video Track that appear within the effect’s duration.

To modify a video effect, double click it in the timeline or select it in the Effect Track and then click Modify (To modify a video effect that has been applied to the entire clip, select the clip and click Effect). The type of modifications that can be made to a video effect depend on the effect properties available.

**Note:** To remove an effect applied to an entire clip, deselect the effect name within the Effect Modification Options window.

Modifying Objects

When you insert an object from the PiP Objects Room into the PiP Track, it has all of the same properties as any other PiP photo or video. Objects can be resized, repositioned, and modified by adding shadows, chroma key effects, etc.

Some objects have pre-defined motion that can be modified or motion can be added to static objects. To modify objects as required, use the following procedures.
Modifying a PiP Effect or Object

A picture-in-picture effect allows you to insert an image, video or object onto an existing image or video clip in your movie, effectively overlaying a picture-in-picture within the existing clip. You can modify the degree of transparency of the overlapping clip, as well as its position, motion and other properties using the PiP Designer.

**Note:** Whenever you adjust any of the options in the PiP Designer, a preview of the effect is instantly displayed for your convenience.

To open the PiP Designer:

- select an item in the PiP Track and then click **Modify**.
- within the PiP Objects room, click on ![image](image) to create a new PiP object template from scratch by importing a custom image.
- within the PiP Objects room, select an existing PiP object and then click on ![image](image) to edit the existing template.

Modify a PiP Effect’s Size and Position

You can change the size, position and orientation of the media clip or object in a PiP effect. Resizing options are unrestricted. You can reduce the clip to miniature size or enlarge it to completely obscure the underlying media file.

To modify its size, position or orientation:

- click and drag a corner or side to resize the PiP object.

  **Note:** Deselect **Keep aspect ratio** to resize the PiP object more freely.

- click on the PiP object and drag it to a new position.
- click on the green dot above the PiP object to change its orientation.
Add Chroma Key Effect to PiP Effect

You can add a chroma key effect by selecting a color within the picture or video clip to reveal the image or video behind it. In effect, the removed color becomes transparent.

Add a Shadow to a PiP Effect

You can add a shadow to the clip or object in a PiP effect. Available options allow you to change the shadow’s color and size, and add a transparency or blur effect.

Add a Border to a PiP Effect

You can add a border around the clip or object in a PiP effect. Available options allow you to change the border’s color and size, and add a transparency or blur effect.

Add Frame to PiP Effect

The PiP Designer lets you add a frame around the PiP photo, video or object that acts like a cookie cutter. The frame will cut out the portion of the PiP photo, video or object, leaving a PiP effect in a creative shape.

Setting PiP Effect Transparency

You can set the level of transparency of the PiP effect in the PiP Designer by using the Transparency slider to set your desired level of transparency for your effect.

Note: The Transparency slider is found on the motion tab.

Add Motion to a PiP Effect

You can add motion to a PiP image, video or object, allowing it to move across the screen. You can choose from a number of pre-defined
motions or create your own custom PiP motion. You can also add a fade-in or fade-out effect to a PiP effect.

**Note:** Some Objects have a pre-defined motion already applied. You can select another predefined motion for these objects as described below.

### Add a Pre-defined Motion to a PiP Effect
To add a pre-defined motion to a PiP effect, click on the Motion tab to display the PiP motion options and then select a pre-defined motion from the available list.

### Customize Rotation of a PiP Effect
To customize the rotation of a PiP effect, enter in the degree of rotation in the **Rotation Settings** section you want the PiP to rotate in the available box, then choose whether:

- to rotate the PiP effect clockwise 🔄.
- to rotate the PiP effect counter clockwise ◐.

### Customize Motion of a PiP Effect
The PiP Designer uses keyframes to determine the location of the PiP effect at a point in time. By changing the location of a keyframe, you can alter the path the PiP effect will take in its motion.

**Note:** Some Objects have predefined motion already applied.

To customize the motion of a PiP effect:

- Drag an existing keyframe to a new location in the preview window. The PiP effect will move along the new path to get to the changed keyframe.
- Drag the path line to alter the path the PiP effect will take to get to the keyframe.
- Click the add keyframe button 📊 to add a new keyframe where required.
Note: You can use the **Remove keyframe** button to remove a highlighted position point, however, there must be a minimum of two keyframes on a PiP effect’s motion path.

### Customize the Speed of PiP Effect Motion

You have full control over the speed of the PiP effect’s motion. The following three factors determine the speed of the PiP effect’s motion.

**Duration of the PiP clip in the timeline**

The longer the PiP clip, the slower the PiP object’s motion will be. For example, if the PiP clip is 10 seconds, it will take the PiP effect 10 seconds to complete the applied motion.

**Distance between keyframes**

The distance between each keyframe also contributes to the speed of the PiP effect motion. The further the distance between each keyframe, the quicker the PiP effect will have to move to get to the next keyframe.

**Keyframe timeline**

The keyframe timeline is located below the preview window. Each keyframe in the motion path has a corresponding marker on the keyframe timeline.

If the PiP clip on the timeline has a duration of 10 seconds, the keyframe timeline will be 10 seconds long. To increase the speed of a PiP effect’s motion, drag a keyframe marker closer to previous keyframe marker.

You can also have the PiP effect momentarily pause its motion if required by expanding a keyframe marker on the keyframe timeline the required duration you want it paused.
Saving and Sharing PiP Templates

Once you have finished modifying your PiP Template you can save it to your PiP Objects Library for future use or upload it to DirectorZone to share it with others.

- click on **Save As** to save the modified template to your PiP Objects Library.
- click on **Share** to upload your custom template to DirectorZone.
- click on **\[\]** to save a modified PiP effect’s motion path as a custom path.

Modify a Title Effect

Using title effects allows you to add text to your movie - as a title at the beginning, an element during the main story or as credits at the very end. Besides changing the look of the text itself, you can also send the text running on a path across the screen. Title effects only affect the clips in the Master Video Track that appear within the title’s duration.

Title effects contain character presets, animation and background options, which you can modify to best suit your movie. All of these options are found in the Title Designer.

**Note:** For comic title effects you can modify both the text and the text bubble in the Title Designer, including its size, position, shadow effects, etc. The procedure for editing comic text bubbles, is the same as for modifying the text effects.

To open the Title Designer:

- select a title effect in the Title Track and then click **Modify**.
- within the Title room, click on **\[\]** to create a new title template from scratch.
- within the Title room, select an existing title effect and then click on **\[\]** to edit the existing template.

To add additional content to your title in the Title Designer:
• click on \[ T \] to add additional text to a title effect.
• click on \[ F \] to add images that accompany the text.

Apply a Character Preset to a Title Effect

You can apply a defined character preset to a title effect. After you have applied the defined character preset you can go to font face, shadow or border settings to make changes to the title effect if required.

To apply a character preset to a title effect, click Text properties tab \[ A \] in the Title Designer, click Character presets tab \[ Aa \], click on text in the preview screen that you would like to change and then choose a character preset from the available list by clicking on it.

Customize a Title Effect’s Font Face

You can customize the font used in a title effect, including the size, color, font type used, weight, alignment, transparency and blur effect. Further tools aid in the precise positioning of the title on the screen and indicate the on-screen area that is safe for TV display.

To customize a title effect’s font face, click on the Text properties tab \[ A \] and then on the Font face settings tab \[ ] .

Add a Shadow to a Title Effect

You can add a shadow around the text in a title effect. Available options allow you to change the shadow’s color and size and add a transparency or blur effect.

To add a shadow to a title effect, click the Text properties tab \[ A \] and then click Font shadow settings tab \[ ] .
Add a Border to a Title Effect

You can add a border around the text in a title effect. Available options allow you to change the border’s color and size and add a transparency or blur effect. When adding a border to a title effect, click the Text properties tab and then click Border settings tab.

Apply Animation to a Title Effect

You can apply animations to a title effect, such as text movements or wipes. Animations can be applied to all the text objects in the title or just to individual text objects. You can apply the animation at the beginning or at the end of the effect, or both.

To apply animation to a title effect, click on the Animation properties tab, select the text object you wish to animate in the Objects list or click on the object in the Preview window.

- Click Begin Effect and select a starting animation effect from the available list.
- Click End Effect and select an ending animation effect from the available list.

Customize the Speed of Title Effect Animation

You can modify the speed of a title effect’s animation. The following two factors determine the speed for the animation to complete.

Duration of the Title Effect clip in the timeline

The longer the duration of the title effect clip in your project’s timeline, the longer it will take for the title effect animation to complete. For example, if the title effect clip is 20 seconds, it will take the title effect 20 seconds to complete the beginning and ending animation.

Keyframe timeline
Chapter 3: Creating Your Story

The keyframe timeline is located below the preview window. By default, the title effect animation has four keyframes.

The first two keyframes indicate the start and end points for the Begin Effect, while the last two indicate the start and end points for the End Effect.

If you would like to change the start or end time of the effect or how long it takes for the beginning or ending effect to complete, just drag a keyframe to the desired position in the timeline.

**Note:** The orange line indicates how long the title effect will be displayed on screen once the Begin effect animation has completed.

### Apply Background Image to a Title Effect

You can apply your own background images to a title effect. The background image is applied to the entire title effect and will overlay the content from the Master Video Track.

To apply a background image to a title effect, click the **Background properties** tab and select the background you wish to use from the Background Image list.

**Note:** If you don’t see a background image you like you can use your own image. Click to add a new image.

### Saving and Sharing Title Templates

Once you have finished modifying your Title Template you can save it to your Title Effects Library for future use or upload it to DirectorZone to share it with others.

- click on **Save As** to save the modified template as a new template in your Title Room.
CyberLink PowerDirector

- click on **Share** to upload your custom title template to DirectorZone.
- click on [button] to save customizations you made to a title effects text properties as a new character preset.
Audio Mixing and Voice Overs

Your production’s audio can make or break your creation. Use the Audio Mixing Room to customize your audio levels or record a voice over to add narration to your movie production.

Splitting Audio from a Video Clip

To make it easier to work with the audio of a video clip, you can split the audio from it by inserting it into the Voice Track.

To split the audio from a video clip, right-click on a video clip in the Timeline and select Split Audio. The audio will be moved from the Master Video Track to the Voice Track.

Note: The Split Audio function does not extract the audio from the video clip as a separate file. To extract the audio from a video clip, see "Extracting Audio from a Video Clip" on page 24.

Change Audio Clip Volume Levels

Your movie production may contain audio in the Music and Voice Tracks, as well as in the video clips you have added. Since all of these tracks may have been recorded at different levels, the result could produce an overwhelming and confusing sound track.

Using CyberLink PowerDirector’s Audio Mixing Room, the audio levels of all of these different tracks can be mixed to produce a more harmonious sound track for your movie. Audio levels can also be mixed inside the audio clips on the Music and Voice Tracks.
**In-Track Audio Mixing**

You can manually change the level of volume at any point within an audio clip in the Timeline.

To change the volume level of an audio track in the Timeline, click on the audio level line at the point where you want to change the audio level to set a volume key. Drag the volume key up to increase the volume or down to decrease the volume.

- Set levels at fewer volume keys along the track for a more subtle change in volume, or more volume keys for a more extreme change in volume.
- To remove a volume key, drag it outside the clip’s borders.

**Mix Audio Levels in the Audio Mixing Room**

Using the Audio Mixer in the Audio Mixing Room gives you very precise control over the volume levels of the audio clips in the workspace. The
Audio Mixer contains audio mixing controls for the different audio tracks in the workspace.

To mix audio levels, click to open the Audio Mixing Room. The audio at the current position of the timeline will be available for mixing. Use the playback controls to locate the position in your movie where you want to mix the audio.

- Use the vertical sliders to set volume keys to increase or decrease the volume of the track at a specific moment.
- Use the horizontal sliders to increase or decrease the volume of the entire track.

**Note:** If there is more than one PiP track in timeline, use the PiP track selector to choose the desired PiP track that you want to mix the audio for.
Add a Fade Effect to an Audio Clip

To add a fade-in/fade-out effect to an audio clip, click on the point in the audio clip you want the fade effect to begin and then:

- click 🎧 to add a fade-in effect.
- click 🔊 to add a fade-out effect.

Restore an Audio Clip’s Volume Levels

If you are dissatisfied with the volume level of any audio clip after manually setting volume keys, you can easily restore the clip’s original volume level. To do this, right-click the track and select Restore to Original Volume Level. Any audio volume keys you have added are permanently removed.

Record a Voice-Over

The Voice-Over Recording Room contains controls for recording a narration from a microphone while watching a preview of your video production. When you capture your narration, the audio track is automatically synchronized with the video portion.
To record a voice-over, click 🎤 to open the Voice-Over Recording Room.

- Set your voice-over options as follows:
  - Select **Device** to select your audio device and input.
  - Select **Profile** to set up the audio quality.
  - Select **Options** to set a recording time limit or 3 second delay before recording begins to ensure you are ready to record. You can also set auto fade in and fade out.
- Set whether to set a fade-in or fade-out effect on the voice-over:
  - Click 🎤 to add a fade-in effect or 🎤 to add a fade-out effect.
Click to begin recording. Record your voice-over as you watch the video in the preview window.

Click to stop recording.
Chapters

Chapters are used to ease navigation of your finalized production when burned to a disc, allowing viewers to watch only the content they want or easily find their place if the disc was stopped before completion.

**Note:** If you choose not to include chapters, your movie will play automatically when the disc is inserted into a player.

To set chapters, click \( \text{ }} \) to open the Chapter Room.

**Set Chapters**

To set chapters, do one of the following:

- To set a chapter at the beginning of each video clip, click \( \text{ }} \).
- To set chapters at fixed intervals, enter an interval (in minutes), then click \( \text{ }} \).
- To set a specified number of chapters evenly on your disc, enter the number of chapters in the entry box, then click \( \text{ }} \).
- To set chapter points manually, navigate to a location on the timeline, then click \( \text{ }} \).
- To remove a chapter point, select it and then click \( \text{ }} \).
- Click \( \text{ }} \) to remove all of the chapter points you have set.

**Set Chapter Thumbnails**

You can customize the thumbnail image for each of your chapters, which will be displayed in your menu. Just click on \( \text{ }} \) when the frame in the preview window is the one that you want to set as the chapter thumbnail.
Subtitles

CyberLink PowerDirector lets you add subtitles to your movie production, either for a disc or imprinted on a video file. Subtitles can be imported from a text file or added manually within the Subtitle Room.

To add a subtitle to your movie production, click the button to open the Subtitle Room. Then click on and select one of the following types of subtitles:

- **Create subtitles for a disc**: selecting this option creates subtitles that are compatible with most disc playback software and can be switched on/off like those found on commercial discs.

  *Note*: When you select **Create subtitles for a disc**, there will be a Subtitles option by default in your created disc menu when created within CyberLink PowerDirector. Text formatting for disc subtitles is more limited.

- **Create subtitles imprinted on a video file**: Select this option to blend subtitles into the video.

Add a Subtitle

To add a subtitle to your movie production, you can:

- Use the playback controls to locate the beginning point of each piece of dialogue that corresponds with the subtitle and then continually click the **Add a subtitle marker** button for each. When you click the stop button, the subtitle entries will be loaded into the subtitle window.

- Click the **Add a subtitle** button to add a single subtitle.
Edit a Subtitle

To edit a subtitle in your movie production, you can:

- Double-click on the subtitle marker in the Timeline or in the Subtitle list view and then enter the text as required.
- Format the subtitle text as required by clicking the **Change text format** button.
- To remove a subtitle, select the subtitle marker and then click the **Remove a subtitle** button.

**Note:** To export your subtitles and save them as an .SRT file, click .

Import Subtitles from a Text File

You can import subtitles from a text file in the .SRT or .TXT formats by clicking on . This allows you to compose your subtitles outside the program or retrieve them from another source and import them into CyberLink PowerDirector.

**Note:** When an SRT file is imported, the subtitles are created automatically in CyberLink PowerDirector. However, for TXT files you must first input all of the subtitle markers.

Syncing Subtitles with Dialogue

To ensure that the subtitles in your movie production sync with the video dialogue, CyberLink PowerDirector provides a number of options for specifying the location.

To set a starting time for a subtitle, do either of the following:

- enter a time code in the **Starting Time** column for the subtitle.
position your cursor at the beginning of the subtitle marker on the Subtitle Track and drag the front of the clip to the new position.

To set an ending time for a subtitle, do either of the following:

- enter a time code in the **Ending Time** column for the subtitle.
- position your cursor at the end of the subtitle marker on the Subtitle Track and drag the end of the clip to the new position.
Chapter 4:

Producing Your Movie

After your movie has been completed, you are ready to produce your movie. Producing a movie simply means compiling (or rendering) the separate elements it contains into a playable movie file. As your movie can be destined for many different uses, CyberLink PowerDirector has several options to produce movies suited for any need.

This chapter contains the following sections:

- "Viewing SVRT Information" on page 84
- "Production Mode" on page 85
- "Create a File" on page 89
- "Create a Streaming File" on page 91
- "Write Back to DV Tape or HDV Tape" on page 93
- "Create an HDD Camcorder File" on page 94
- "Uploading Video" on page 95
- "Batch Production" on page 96
SVRT (Smart Video Rendering Technology) is a proprietary rendering technology from CyberLink that recognizes which portions of a movie clip have been modified (and therefore require rendering during production), and which portions of a movie clip have not been changed (and thus can be skipped over during rendering). By viewing SVRT information, you can simulate the production process.

**Note:** For more information on SVRT, see "SVRT: When Can I Use it?" on page 120.

To view how CyberLink PowerDirector uses SVRT in your current project, click > View > SVRT Information.

The colors that appear in the SVRT track designate how CyberLink PowerDirector uses SVRT for the related clip (or clip portion).

- **Green:** no rendering is required during production.
- **Blue:** only video rendering is required.
- **Yellow:** only audio rendering is required.
- **Red:** both audio and video rendering is required.
Production Mode

When you click the Produce button, CyberLink PowerDirector enters the Produce Mode. Here you can compile your movie into a file that is ready for a variety of destinations, including burning to a disc or upload to the Internet.
Production Wizard

CyberLink PowerDirector uses the Production Wizard to assist you to finalize your production. When you click the Produce button, the Production Wizard is displayed as follows:

- **Preview window**: Provides playback controls to preview your movie.
- **Production mode buttons**
- **Information display areas**: Displays used space, disk, and other information.

The Production Wizard is a simple interface that makes movie production easy.
Note: Before producing your movie, make sure that all of your video clips have the same interlacing format. This is an extremely important step to take before production, as it can drastically affect final video quality! If you produce your movie and find the video quality unsatisfactory, verify that the interlacing format of all of your video clips is the same. If your clips have different interlacing formats, set them all to the same format, then produce your movie again. For more information, see "Set a Video Clip's Interlacing Format" on page 57.

The first window of the Production Wizard contains a preview window, a visual display of your hard disk space, and five buttons corresponding to the five production options available in The Production Wizard. These are described below:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create a File</strong></td>
<td>Allows you to create a movie production that you can then watch on your computer. See &quot;Create a File&quot; on page 89.</td>
</tr>
<tr>
<td><strong>Create a Streaming File</strong></td>
<td>Allows you to create a movie production that you can then stream over the Internet. See &quot;Create a Streaming File&quot; on page 91.</td>
</tr>
<tr>
<td><strong>Write Back to DV Tape</strong></td>
<td>Allows you to create a movie production that you can then write back to DV tape. See &quot;Write Back to DV Tape or HDV Tape&quot; on page 93.</td>
</tr>
<tr>
<td><strong>Write Back to HDV Tape</strong></td>
<td>Allows you to create a movie production that you can then write back to HDV tape. See &quot;Write Back to DV Tape or HDV Tape&quot; on page 93.</td>
</tr>
<tr>
<td><strong>Create an HDD Camcorder File</strong></td>
<td>Allows you to create a video file that can be copied back to a hard disk drive camcorder. See &quot;Create an HDD Camcorder File&quot; on page 94.</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Upload to YouTube®</strong></td>
<td>Allows you to upload your video production to the Internet to share with the world. See &quot;Uploading Video to YouTube&quot; on page 95.</td>
</tr>
</tbody>
</table>
Create a File

You can produce your movie as a video file that you can watch on your computer, burn to disc or output to a portable device.

Create/Modify a Video File Profile

Before producing a video file, you may want to create a new profile or modify an existing profile for the file type you are creating. Profile Settings let you configure video and audio quality, bitrate compression, etc. for each file to customize the outputted file for advanced user requirements.

Creating a Video File

CyberLink PowerDirector lets you produce video files in a variety of formats, outputted in the quality to fit your specific requirements.
You can produce your video in one of the following formats:

- AVI
- MPEG1
- MPEG2
- Portable MPEG4
- AVC MPEG4

**Note:** The type of files that can be created depend on the version of CyberLink PowerDirector that is installed on your computer. Please see the Readme for information on the file types your version supports.
Chapter 4: Producing Your Movie

Create a Streaming File

You can produce your movie as a video file that can be stored on a server for streaming over the Internet.

Create/Modify a Streaming File Profile

Before producing a streaming file, you may want to create a new profile or modify an existing profile for the file type you are creating. Profile Settings let you configure video and audio quality, compression settings, etc. for each file to customize the outputted file for advanced user requirements.
Create a File for Streaming

CyberLink PowerDirector lets you produce files for streaming in a variety of formats, outputted in the quality to fit your specific requirements.

You can produce your video in one of the following formats:

- (WMV) Windows Media Video
- RealVideo
- QuickTime Movie

**Note:** The type of files that can be created depend on the version of CyberLink PowerDirector that is installed on your computer. Please see the Readme for information on the file types your version supports. This is an extremely important step to take before producing your final movie, as it can drastically affect final video quality.
Write Back to DV Tape or HDV Tape

You may want to produce your movie and then write it back to a DV or an HDV tape. This allows you to store your movie in a convenient, digital format that can easily be imported into another computer for further editing.

Note: You must manually locate the position on your HDV camcorder tape where you want to write back your content to before proceeding.
Create an HDD Camcorder File

You may want to produce your movie and then copy it back to a hard disk drive camcorder. This allows you to store your movie in a convenient, digital format that can easily be imported onto another computer for further editing.
Chapter 4: Producing Your Movie

Uploading Video

CyberLink PowerDirector makes it easy to upload your created movie productions to the Internet. In just a few steps, you can upload your production from within CyberLink PowerDirector directly to YouTube®.

Uploading Video to YouTube

To upload your video to YouTube®, follow the detailed instructions on the user interface.
Batch Production

You can produce multiple created movie projects at one time in CyberLink PowerDirector using the Batch Produce feature.

To perform a batch production, select File > Batch Produce.
Chapter 5:

Creating Discs

After your movie production has been completed, you can create a disc to play your video on a DVD or other disc player. You can burn your movie onto a CD, DVD or Blu-ray Disc (Ultra version only) in three simple steps. Integrated authoring allows you to view your movie in the living room instantly after you have produced your movie. You will never have to launch another program again to create a video disc.

This chapter contains the following sections:

- "Create Disc Mode" on page 98
- "Disc Menus" on page 99
- "Configure Create Disc Preferences" on page 107
- "Burn to Disc" on page 109
Create Disc Mode

When you click the **Create Disc** button, CyberLink PowerDirector enters the Create Disc mode, where you can customize your disc’s menu and burn your movie onto a CD, DVD or Blu-ray Disc (Ultra version only). In the Create Disc mode, the program appears as follows:

- **Access the Menu Designer**
- **Author/Preview windows**
- **Menu templates**
- **Add menu music and first play video**
Disc Menus

Before you burn your movie to a disc, you can add a disc menu for navigating around your disc. Within the Create Disc window, you can:

- select an existing, pre-designed disc menu template
- make modifications to an existing disc menu template
- create a brand new disc menu template

**Note:** If you don't want your disc to contain a disc menu, simply select **Create a disc without a menu**. The video will play automatically when the disc is inserted into a disc player.

All the menu templates within CyberLink PowerDirector are multi-layered, consisting of a main menu home page with text links to play your movie, select chapters or turn on subtitles if included on your disc.

**Note:** The Subtitles page within disc menus will only be available if you selected **Create subtitles for disc** when creating subtitles in the Subtitle Room. See "Subtitles" on page 80 for more information.

Selecting Pre-designed Templates

CyberLink PowerDirector provides you with several stylish pre-designed templates that you can choose from. These menus have already been customized for you and may include such features as motion and menu music.

The menu page templates can be divided into two categories:

- menu templates with clickable chapter thumbnail buttons
- menu templates with clickable chapter text.

Downloading Templates from DirectorZone

If you are looking for additional disc menu templates, you can download them from the DirectorZone web site by clicking on within the Template section of the Create Disc window.
The additional templates are created by either CyberLink or other CyberLink PowerDirector users, who have uploaded them to DirectorZone.

You may also import menu templates in the .DZM format into the Template section of the Create Disc window by clicking on .

**Customizing Disc Menu**

CyberLink PowerDirector gives you full creative control over the look and creation of your disc menu. Within the Create Disc window you can:

- add background music or a first play video
- customize menu text font and layout in the Menu Designer
- import custom background images, video and images in the Menu Designer
- customize the button layout, design and effects in the Menu Designer
- add video effects and set menu motion

**Specify Buttons Per Page**

When creating a movie disc with multiple chapters, you can select from a number of layouts for the chapter page. Just select one of the available chapter thumbnail button layouts in the **Buttons per page** pane.

*Note:* If you selected a menu template that uses clickable chapter text, there will be just one button layout available.

**Setting Disc Menu Background Music**

Some of the pre-designed disc menu templates contain menu music. You can edit the existing music or add new music as your menu background music by clicking on . You can also:

- click to remove the audio track.
• click 🎵 to add background music with Magic Music. The procedure is the same as Magic Music tool. See "Magic Music" on page 62 for more information.

• click 🎵 to preview the menu music.

Set a First Play Video Clip

A clip designated as first play is the initial sequence that plays as soon as a disc is inserted into a computer for play, and before the menu page appears. No navigation buttons are available during the first play, and viewers cannot fast forward past this segment. In a professional production, first play typically consists of a copyright notice or warning. However, you may prefer to use a personal introduction or other video clip instead.

To set a clip as first play:

• click 🎵 and select the video file that you want.

• click 🎵 to remove the file set as first play.

• click 🎵 to preview the first play video.
Using the Menu Designer

The Menu Designer lets you customize a selected disc menu style or create your own menu style.

To open the Menu Designer to customize your menu:

- click **New** and create a brand new menu template.
- select an existing menu template and click **Modify**.

Within the Menu Designer you can edit all three possible disc menu pages. To modify a specific page, select either Home Page, Chapter Page or Subtitles Page from the **Go to** drop-down menu.

**Note:** The Subtitles Page will only be available in the **Go to** drop-down menu if you selected **Create subtitles for disc** when creating subtitles in the Subtitle Room. See "Subtitles" on page 80 for more information.
Modify Menu Text
To edit text that appears on the menu page, including clickable chapter text, double-click it in the Menu Designer, and then enter the new text.

Note: Make sure you are in the Edit mode when trying to modify text.

Apply a Preset Character Type to Menu Text
You can apply a pre-defined character preset for the menu text. After you have applied the pre-defined character preset you can go to font face, shadow, or border tabs to make changes to the title effect if required.

Customize Menu Text Font Face
You can customize the font used in menu text, including the size, color, font type used, weight, alignment, transparency and blur effect. Further tools aid in the precise positioning of the title on the screen and indicate the on-screen area that is safe for TV display.

Add a Shadow to Menu Text
You can add a shadow around the text in the menu. Available options allow you to change the shadow’s color and size and add a transparency or blur effect.

Add a Border to Menu Text
You can add a border around the text in the menu text. Available options allow you to change the border’s color and size and add a transparency or blur effect.

The procedure for adding a border to menu text is the same as adding a border to title effect text. See step 2 in "Add a Border to a Title Effect" on page 70 for detailed information on adding a border to menu text.

Set Object Effects
Use the Set object effects tab in the Menu Designer to customize all of your menus effects. The tab lists all of the current objects on your menu, including menu buttons, navigation buttons and text. To set the object
effects, click on the **Set objects effects** tab in the Menu Designer.

When you select an item in the Objects list, the object will be highlighted in the preview window. Once highlighted, the objects can be easily edited, resized, reshaped or moved around the disc menu to a desired location.

**Note:** When creating a menu with clickable chapter text, use the Set Object Effects tab to easily select, edit and position the clickable text objects in the desired position.

- **Select Display the selected object only** to only display the selected object while setting the effects.

You can also add new objects, such as import custom images, text fields and buttons. Do this:

- **click** to import a custom image into your disc menu.
- **click** to add a new blank text field into your disc menu.
- **click** to add a button into your disc menu.

**Set Button Effects**

You can customize your menu and navigation buttons for your disc menu in the Menu Designer, by selecting a button frame, setting button position or setting a button highlight style.

**Note:** If you selected a menu template that uses clickable chapter text, you can only customize the menu’s navigation buttons.

To set the object effects, click on the **Set button effects** tab in the Menu Designer and set the effects as follows:

- **Click on** to select a chapter thumbnail button frame style. **Select Import Custom** to import your own button frame style.
- **Click on** to set chapter thumbnail button layout.
Chapter 5: Creating Discs

- Click on to select a navigation button style. Select Import Custom to import your own navigation button style.

- Click on to select a button highlight style. Select Import Custom to import your own button highlight style.

**Replace Background Image or Video**

To replace the background image or video in your disc menu, click on the **Replace background image or video** button.

**Select a Video Effect**

To select a video effect that will be dynamically applied to your disc menu, click on the **Select a video effect** button.

**Saving and Sharing Disc Menu Templates**

Once you have finished modifying your disc menu template you can save it to the Template section of the Create Disc window for future use or upload it to DirectorZone to share it with others.

- click on **Save As** to save the modified template to the Template section of the Create Disc window
- click on **Share** to upload your custom template to DirectorZone.
Preview Your Disc’s Menu Page

At any time during the creation of your disc menu within the Create Disc Window or Menu Designer, click on Preview to preview your disc menu page. Click a button to preview the chapter associated with the button. Use the playback buttons to control the preview.

- Click Author to return to the Author mode.
Chapter 5: Creating Discs

Configure Create Disc Preferences

Before you proceed to burn your creation disc, it is recommended that you configure the Create Disc Preferences. Click to configure your Create Disc Preferences.

The following options are available under the Disc Format tab:

- **Disc format**: Select the disc format you will be using to burn your movie.
- **Disc capacity**: Select the disc capacity of your disc.
- **Video quality**: Select a video quality for your disc: DVD LP (Long Play), DVD SP (Standard Play), DVD HQ (High Quality), or Smart Fit. The video quality settings offer different bit rates, resulting in files of different size. The higher the quality of the video, the larger the resulting file and the shorter the length of video that can fit onto a disc. Further, more CPU power is required for rendering higher quality video. The **Smart Fit** option automatically adjusts the bit rate to the best quality video file that fits exactly to the capacity of the disc you are using.
- **Audio type**: The different audio types are as follows: LPCM is an uncompressed audio format. Dolby Digital audio uses the Dolby Digital Consumer Encoder format. MPEG audio uses the MPEG-1 audio compression format. (This audio format may have compatibility issues in NTSC.)

**Note**: The video quality and audio type options that are available depend on the disc format that you have selected.

The following options are available under the Menu tab:

- **Enable video thumbnail**: Select to allow chapter thumbnails to display video on the disc’s menu. If you select this option, you can limit the length of video that displays by entering a value for the **User-defined motion menu duration** option.
• **Auto menu time-out**: Select this option to have your video play automatically after a period of time.

The following option is available under the **Audio** tab:

• **Dolby Digital 5.1**: select this option to enable Dolby Digital 5.1 on your disc.

• **Apply CyberLink VirtualSpeaker to enhance background music**: Check this option to enable CyberLink VirtualSpeaker to enhance background music. Choose between **Living Room**, **Theater**, and **Stadium**.
Burn to Disc

After you have acquired your media, assembled your story, edited your clips, added audio and visual effects, and customized the layout and look of your disc, then it’s time to finalize your production.

CyberLink PowerDirector offers several methods to finalize your production, which are useful under different circumstances. You can burn your production to disc as the last step in your movie production process, save your production as a disc image for later burning, or create a DVD folder to organize your media files on your hard drive. Depending on your burning drive and disc type, one or more of these options may be available simultaneously.

CyberLink PowerDirector supports the following disc formats for burning:

- **DVD**: DVD-R, DVD-RW, DVD+R, DVD+RW
- **VCD/SVCD**: CD-R, CD-RW
- **Blu-ray Disc (Ultra and HE version only)**: BD-RE, BD-R

*Note*: See "Configure Create Disc Preferences" on page 107 for information on selecting your disc type for burning.

Burn Your Movie to Disc

Burning your movie to disc is the final stage of the create disc process. Once your disc is burned, you will be able to play it on a disc player to share with your family and friends. Click on the Burn button to begin the burning process.

*Note*: The burning process may take at least a few minutes, depending on the length and quality of your video and your computer’s processing power. Be prepared for a short wait while CyberLink PowerDirector renders your movie!
Note: HD Content captured from HDV camcorders will be converted to standard definition (SD) format when burning to DVD discs. This is because DVD accepts only SD format. HD format will be supported on the high capacity Blu-ray discs when it becomes available.

Set Your Burning Configuration

Before you burn to disc for the first time, set your burning configuration on the Burn window. After you set this configuration, CyberLink PowerDirector uses the same configuration each time you burn until you change the settings.

Create a DVD Folder

Selecting Create a DVD folder creates a folder on your computer that contains all the files necessary for burning. This folder can then be burned to disc at a later date.

Note: Creating a DVD folder overwrites existing data in a directory.

Erase a Disc

If you are using a rewritable disc, you can erase content that has data previously recorded on it. This allows you to reuse the same discs over and over without the need to continually buy new discs. Click on the Erase button to begin erasing a disc.

When erasing a disc, you can select:

- the **Quick** option to erase the disc index contained on the disc.
- the **Full** option to erase all of the content the disc contains.
Appendix

This chapter contains reference information to help answer questions you may have about the digital movie production process or about using CyberLink PowerDirector.

This chapter contains the following sections:

- "Hotkeys" on page 112
- "SVRT: When Can I Use it?" on page 120
- "Licenses and Copyrights" on page 121
Hotkeys

CyberLink PowerDirector allows you to employ a number of hotkeys to make working with video quicker and easier. These hotkeys are organized by function and described below.

## System Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt + space bar</td>
<td>Open the Minimize menu in the top-left corner</td>
</tr>
<tr>
<td>Alt + F4</td>
<td>Exit CyberLink PowerDirector</td>
</tr>
</tbody>
</table>

## Project Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + N</td>
<td>Create new project</td>
</tr>
<tr>
<td>Ctrl + O</td>
<td>Open existing project</td>
</tr>
<tr>
<td>Alt + Enter</td>
<td>Display project properties</td>
</tr>
<tr>
<td>Ctrl + S</td>
<td>Save project</td>
</tr>
<tr>
<td>Ctrl + Shift + S</td>
<td>Save project as</td>
</tr>
<tr>
<td>Ctrl + Shift + W</td>
<td>New Workspace</td>
</tr>
</tbody>
</table>
## Workspace Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab</td>
<td>Switch between Timeline/Storyboard</td>
</tr>
<tr>
<td>Home</td>
<td>Go to the beginning of clip/project</td>
</tr>
<tr>
<td>End</td>
<td>Go to the end of clip/project</td>
</tr>
<tr>
<td>Alt+1</td>
<td>Opens the Magic Clean function</td>
</tr>
<tr>
<td>Alt+2</td>
<td>Opens the Magic Motion function</td>
</tr>
<tr>
<td>Alt+3</td>
<td>Opens the Magic Cut function</td>
</tr>
<tr>
<td>Alt+4</td>
<td>Opens the Magic Fix function</td>
</tr>
<tr>
<td>Alt+5</td>
<td>Opens the Magic Style function</td>
</tr>
<tr>
<td>Alt+6</td>
<td>Opens the Magic Music function</td>
</tr>
<tr>
<td>Alt+7</td>
<td>Opens the Magic Movie Wizard</td>
</tr>
<tr>
<td>Ctrl + right arrow</td>
<td>Go to next clip in the track (Clip mode)</td>
</tr>
<tr>
<td>Ctrl + left arrow</td>
<td>Go to previous clip in the track (Clip mode)</td>
</tr>
<tr>
<td>Ctrl + C</td>
<td>Copy</td>
</tr>
<tr>
<td>Ctrl + X</td>
<td>Cut</td>
</tr>
<tr>
<td>Ctrl + V</td>
<td>Paste</td>
</tr>
<tr>
<td>+</td>
<td>Zoom ruler In</td>
</tr>
<tr>
<td>-</td>
<td>Zoom ruler out</td>
</tr>
<tr>
<td>Alt + L</td>
<td>Lock all tracks except Master Video track</td>
</tr>
</tbody>
</table>
### Menu Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt + F</td>
<td>Open File menu</td>
</tr>
<tr>
<td>Alt + E</td>
<td>Open Edit menu</td>
</tr>
<tr>
<td>Alt + V</td>
<td>Open View menu</td>
</tr>
<tr>
<td>Alt + T</td>
<td>Open Capture menu</td>
</tr>
<tr>
<td>Alt + P</td>
<td>Open Playback menu</td>
</tr>
<tr>
<td>Alt + H</td>
<td>Open Help menu</td>
</tr>
</tbody>
</table>
## Smart Guide Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + Alt + T</td>
<td>Display Trim options</td>
</tr>
<tr>
<td>Ctrl + Alt + S</td>
<td>Display Speed options</td>
</tr>
<tr>
<td>Ctrl + Alt + C</td>
<td>Display Color options</td>
</tr>
<tr>
<td>Ctrl + Alt + M</td>
<td>Display Multi Trim options</td>
</tr>
<tr>
<td>F2</td>
<td>Display PiP Modification Options/Title Designer/Effect Modification Options</td>
</tr>
</tbody>
</table>

## Main Panel Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Help</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete selected item(s)</td>
</tr>
<tr>
<td>Ctrl + Z</td>
<td>Undo</td>
</tr>
<tr>
<td>Ctrl + Y</td>
<td>Redo</td>
</tr>
<tr>
<td>Shift + F12</td>
<td>Show Hotkey list help</td>
</tr>
<tr>
<td>Alt + F9</td>
<td>Switch to Capture mode</td>
</tr>
<tr>
<td>Alt + F10</td>
<td>Switch to Edit mode</td>
</tr>
<tr>
<td>Alt + F11</td>
<td>Switch to Produce mode</td>
</tr>
<tr>
<td>Alt + F12</td>
<td>Switch to Create Disc mode</td>
</tr>
</tbody>
</table>
# Library Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F3</td>
<td>Open Media Room</td>
</tr>
<tr>
<td>F4</td>
<td>Open Effect Room</td>
</tr>
<tr>
<td>F5</td>
<td>Open PiP Objects Room</td>
</tr>
<tr>
<td>F6</td>
<td>Open Title Room</td>
</tr>
<tr>
<td>F7</td>
<td>Open Transition Room</td>
</tr>
<tr>
<td>F8</td>
<td>Open Audio Mixing Room</td>
</tr>
<tr>
<td>F9</td>
<td>Open Voice-Over Recording Room</td>
</tr>
<tr>
<td>F10</td>
<td>Open Chapter-Setting Room</td>
</tr>
<tr>
<td>F11</td>
<td>Open Subtitle Room</td>
</tr>
<tr>
<td>Ctrl + Enter</td>
<td>Display media in Media Viewer</td>
</tr>
<tr>
<td>Ctrl + A</td>
<td>Select all</td>
</tr>
<tr>
<td>Ctrl + Tab</td>
<td>Switch between filters</td>
</tr>
<tr>
<td>Ctrl + D</td>
<td>Detect scenes</td>
</tr>
<tr>
<td>Ctrl + Q</td>
<td>Import media file(s)</td>
</tr>
<tr>
<td>Ctrl + W</td>
<td>Import a media folder</td>
</tr>
</tbody>
</table>
## Capture Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + R</td>
<td>Record</td>
</tr>
<tr>
<td>Alt + R</td>
<td>Start recording</td>
</tr>
<tr>
<td>Ctrl + /</td>
<td>Stop recording</td>
</tr>
<tr>
<td>Space bar</td>
<td>DV play/pause</td>
</tr>
<tr>
<td>Ctrl + , (comma)</td>
<td>DV rewind</td>
</tr>
<tr>
<td>Ctrl + . (period)</td>
<td>DV fast forward</td>
</tr>
<tr>
<td>Ctrl + /</td>
<td>DV stop</td>
</tr>
<tr>
<td>Alt + Y</td>
<td>Add text captions on captured video</td>
</tr>
</tbody>
</table>

## Voice-Over Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + H</td>
<td>Fade in</td>
</tr>
<tr>
<td>Ctrl + J</td>
<td>Fade out</td>
</tr>
<tr>
<td>Ctrl + R</td>
<td>Start recording</td>
</tr>
<tr>
<td>Ctrl + /</td>
<td>Stop recording</td>
</tr>
</tbody>
</table>
## Preview Window Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space</td>
<td>Play/pause</td>
</tr>
<tr>
<td>Ctrl + /</td>
<td>Stop</td>
</tr>
<tr>
<td>, (comma)</td>
<td>Previous unit</td>
</tr>
<tr>
<td>. (period)</td>
<td>Next unit</td>
</tr>
<tr>
<td>Page Up</td>
<td>Switch to Clip mode</td>
</tr>
<tr>
<td>Page Down</td>
<td>Switch to Movie mode</td>
</tr>
<tr>
<td>Ctrl+F</td>
<td>Fast forward</td>
</tr>
<tr>
<td>[</td>
<td>Mark in</td>
</tr>
<tr>
<td>]</td>
<td>Mark out</td>
</tr>
<tr>
<td>Ctrl + T</td>
<td>Split</td>
</tr>
<tr>
<td>Ctrl + G</td>
<td>Goto time code</td>
</tr>
<tr>
<td>Ctrl + E</td>
<td>Display Precise Cut trimmer (when enabled)</td>
</tr>
<tr>
<td>Ctrl + Enter</td>
<td>Display media in Media Viewer</td>
</tr>
<tr>
<td>Ctrl + P</td>
<td>Takes a snapshot of content in the preview window</td>
</tr>
<tr>
<td>Ctrl + + (plus)</td>
<td>Increase volume</td>
</tr>
<tr>
<td>Ctrl + - (minus)</td>
<td>Decrease volume</td>
</tr>
<tr>
<td>Ctrl + Backspace</td>
<td>Mute/Mute off</td>
</tr>
<tr>
<td>Ctrl + U</td>
<td>Adjust system volume</td>
</tr>
</tbody>
</table>
# Title Designer Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + B</td>
<td>Set text in bold</td>
</tr>
<tr>
<td>Ctrl + I</td>
<td>Set text in italics</td>
</tr>
<tr>
<td>Ctrl + L</td>
<td>Left-align text</td>
</tr>
<tr>
<td>Ctrl + R</td>
<td>Right-align text</td>
</tr>
<tr>
<td>Ctrl + E</td>
<td>Center-align text</td>
</tr>
<tr>
<td>Ctrl + T</td>
<td>Show/hide TV Safe lines</td>
</tr>
<tr>
<td>Ctrl + G</td>
<td>Show/hide Gridlines</td>
</tr>
</tbody>
</table>

# PiP Designer Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + T</td>
<td>Show/hide TV Safe lines</td>
</tr>
<tr>
<td>Ctrl + G</td>
<td>Show/hide Gridlines</td>
</tr>
</tbody>
</table>
SVRT: When Can I Use it?

SVRT can be applied to video clips in the MPEG-1, MPEG-2 and DV-AVI (Type I) formats. In the following conditions, clips (or portions of clips) do not require rendering during production, and SVRT can therefore be applied:

- The frame rate, frame size, and file format are the same as those of the destination production profile.
- The bitrate is similar to that of the destination production profile.
- The TV format is the same as that of the destination production profile. For more information, see "Set a Video Clip's Interlacing Format" on page 57.

If all of the above conditions are met, SVRT can be used. Any clips that do not meet the above criteria are fully rendered without SVRT.

In the following conditions, clips (or portions of clips) must be rendered during production, and SVRT can therefore not be applied:

- Adding a title or transition effect
- Modifying the color of a video clip
- Audio profile does not match destination production profile
- Modifying the volume of an audio clip
- Merging two video clips (clips within 2 seconds before or after the merged clips will be rendered)
- Splitting a video clip (clips within 2 seconds before or after the split will be rendered)
- Trimming a video clip (clips within 2 seconds before or after the trimmed clip will be rendered)
- If the total duration of the production is less than one minute and any portion of the video requires rendering, the entire production will be rendered for efficiency reasons.
Licenses and Copyrights

This document contains the CyberLink PowerDirector licensing and copyright information for Dolby Laboratories only. For the remaining list of applicable licensing and copyright information for CyberLink PowerDirector, please consult the Readme file.

Dolby Laboratories

Manufactured under license from Dolby Laboratories. “Dolby”, and the double-D symbol are trademarks of Dolby Laboratories. Confidential unpublished works. Copyright 1992-1997 Dolby Laboratories. All rights reserved.
Chapter 7:

Technical Support

This chapter contains technical support information. It includes all the information to find the answers you need to assist you. You may also find answers quickly by contacting your local distributor/dealer.

This chapter contains the following sections:

- "Before Contacting Technical Support" on page 124
- "Web Support" on page 125
Before Contacting Technical Support

Please take advantage of one of CyberLink's free technical support options:

- consult the User Guide or the online help installed with your program.
- refer to the Frequently Asked Questions (FAQs) in the Support section of the CyberLink Web site.

http://www.cyberlink.com/multi/support/product_faq_home.jsp

The FAQs may have information and helpful hints that are more current than the User Guide and online help.

When contacting technical support by email or phone, please have the following information ready:

- registered Activation Key (Your Activation Key can be found on the CD cover, the Box cover, or in the email received after you purchased CyberLink products on the Cyberlink store.)
- the product name, version and build number, which generally can be found by clicking on the product name image on the user interface
- the version of Windows installed on your system
- hardware devices on your system (capture card, sound card, VGA card) and their specifications
- the wording of any warning messages that were displayed (You may want to write this down or take a screen capture)
- a detailed description of the problem and under what circumstances it occurred
Web Support

Solutions to your problems are available 24 hours a day at no cost on the CyberLink web sites:

**Note:** You must first register as a member before using CyberLink web support.

CyberLink provides a wide range of web support options, including FAQs and a user community forum, in the following languages:

<table>
<thead>
<tr>
<th>Language</th>
<th>Web Support URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td><a href="http://www.cyberlink.com/CS/support/enu/support_index.jsp">http://www.cyberlink.com/CS/support/enu/support_index.jsp</a></td>
</tr>
<tr>
<td>Traditional Chinese</td>
<td><a href="http://tw.cyberlink.com/CS/support/cht/support_index.jsp">http://tw.cyberlink.com/CS/support/cht/support_index.jsp</a></td>
</tr>
<tr>
<td>Japanese</td>
<td><a href="http://jp.cyberlink.com/jpn/support_jpn/support_index.jsp">http://jp.cyberlink.com/jpn/support_jpn/support_index.jsp</a></td>
</tr>
<tr>
<td>Italian</td>
<td><a href="http://it.cyberlink.com/CS/support/ita/support_index.jsp">http://it.cyberlink.com/CS/support/ita/support_index.jsp</a></td>
</tr>
<tr>
<td>German</td>
<td><a href="http://de.cyberlink.com/CS/support/deu/support_index.jsp">http://de.cyberlink.com/CS/support/deu/support_index.jsp</a></td>
</tr>
<tr>
<td>French</td>
<td><a href="http://fr.cyberlink.com/CS/support/fra/support_index.jsp">http://fr.cyberlink.com/CS/support/fra/support_index.jsp</a></td>
</tr>
<tr>
<td>Spanish</td>
<td><a href="http://es.cyberlink.com/CS/support/esp/support_index.jsp">http://es.cyberlink.com/CS/support/esp/support_index.jsp</a></td>
</tr>
</tbody>
</table>
Index

A
Aspect ratio
adjust 58
setting 34
Audio
adding clips to the workspace 48
change levels 73
in-track mixing 74
Magic Music 62
mixer 75
mixing room 38
record voice-over 76
restore volume 76
split from video 73
trimming 54
types 107
Audio mixer 74
Auto menu time-out 108

B
Batch production 96
Burning
configuration 110
capture DVD folder 110

C
Capture
from CD 22
from Digital TV 22
from DV device 20
from DVD 22
from HDV device 21
from microphone 22
from PC camera 22
from TV 21
from webcam 22
limit options 19
modes 18
options 19
overview 17
preferences 29
single scene 20
CD, capturing 22
Chapters
overview 38
set thumbnail 79
setting 79
Chroma key effect 65
Color boards, adding 48
Confirmation preferences 28
Create a DVD folder 110

Buttons
frame style 104
highlight style 105
layout 104
navigation 105
per page 100
set effects 104

over view 109
Create disc
  add music 100
  customize 100
  menu designer 102
  modify text 103
  new features 3
  overview 98
  preferences 107
  preview 106
Create slideshow 44
CyberLink VirtualSpeaker 108

D
Date caption 19, 57
Default durations, setting 28
Detecting scenes, in video clips 23
Digital TV, capture 22
DirectorZone
  downloading templates 16, 99
  overview 4
  preferences 30
Disc formats supported 109
Disc menus
  add music 100
  auto time-out 108
  button effects 104
  button frame 104
  button highlight 105
  button layout 104
  buttons per page 100
  customize 100
  download 99
  first play video 101
  menu designer 102
  modify text 103
  navigation button 105
  overview 98
  preferences 107
  preview 106
  save 105
  share 105
  template style 99
  text shadow 103
  video effect 105
  video thumbnail 107
Dolby Digital 107
Dolby Digital 5.1 108
Downloading
  audio 15
  disc menu templates 99
  media 14
  photos 14
  PiP templates 16
  title templates 16
Duration
  default 28
  of capture 19
DV
  camcorder, capturing 20
  parameters 30
  tape, writing to 93
DV Backup 20
DVD, capturing 22

E
Editing
  new features 2
  preferences 27
Effect track
  adding effects 49
Index

description 40
Effects, overview 37
Erasing discs 110
EXIF 57
Extract audio 24

F
Fade-in 76
Fade-out 76
Fast-motion 56
File formats 14
File preferences 25
First play video 101
Fit timeline 40
Flickr 14
Frame in PiP effects 65
Freesound 15
Freeze frame 56
Full erase 110

G
General preferences 26

H
HDV
camcorder, capturing 21
tape, writing to 93
Hotkeys 112

I
Import
audio 15
background image 105
buttons 105
file formats 14
media 14
photos 14
subtitles 81
Interlacing format, setting 57
In-track audio mixing 74

L
Language, change 27
Latest features 2
Library
detecting scenes in clips 23
manage 2, 37
new features 2
overview 36

M
Magic Clean 60
Magic Cut 61
Magic Fix 61
Magic Motion 60
Magic Movie Wizard 60
Magic Movie wizard 43
Magic Music 62
Magic Style 61
Manage library 2, 37
Maximum undo levels, setting 26
Media room 36
Media viewer 53
Menu designer
  button effects 104
  button frame 104
  button highlight 105
  button layout 104
  modify text 103
  navigation buttons 105
  overview 102
  text shadow 103
  video effect 105
Microphone, capturing 22
Mixing
  audio 74
  in-track 74
Mixing audio 75
Modifying effects
  title 68
  video 63
Motion
  adding to image clip 60
  of PiP effects, modifying 65
Motion designer 60
Music
  disc menus 100
Music track
  adding clips 48
  description 40
Mute
  audio tracks 56
  entire track 56

N
Narration, recording 76
Navigation buttons 105

O
OEM versions 4

P
PC camera, capturing 22
PC camera, capturing from 22
Photos
  adding to workspace 47
  Magic Fix 61
PiP designer 64
PiP effect
  modifying 64
  speed 67
PiP effects
  adding frame 65
  customize motion 66
  customize rotation 66
  modifying motion 65
  modifying position 64
  modifying size 64
  pre-defined motion 66
  save 68
  shadows 65
  share 68
  transparency 65
PiP Objects
modifying 64
PiP objects
  add PiP tracks 3, 40, 47
  adding to timeline 50
donload 16
overview 37
PiP track
  add 40
  adding media 47
  adding objects 50
description 40
PowerDirector
  modes 7
  preferences 25
  projects 8
  upgrade 4
  versions 4
Preferences 25
  disc menu 107
Preview
  disc menu 106
  window 52
  your production 52
Produce
  create an HDD camcorder file 94
  multiple projects 96
  new features 3
  overview 85
  preferences 30
  streaming video file 92
  upload to YouTube 95
  video file 89
  write back to DV tape 93
  write back to HDV tape 93
  your movie 83
  producing 89
  Production process 9
Profiles 19, 89
Q
  Quality
    capture 19
    disc 107
    produced video 89
  Quick erase 110
R
  Record voice-over 76
  Resizing the ruler 41
  Restoring volume levels 76
  RichVideo 57
  Ripping CD tracks 22
  Ruler, resizing 41
S
  Save
    character preset 72
    disc menu template 105
    PiP motion path 68
    PiP template 68
    title template 71
  Scene detection 23
  Set chapter thumbnail 79
  Set chapters 79
  Settings
    default durations 28
maximum undo levels 26
Shadows
  in menu text 103
  in PiP effects 65
  in title effects 69, 70
Share
  disc menu template 105
  PiP template 68
  title template 71
  video on YouTube 95
Size limit for captures 19
Slideshow
  advanced settings 46
  designer 44
Slow-motion 56
Smart fit 107
Snapshot
  default destination 26
  default filename 25
Speed
  PiP effect 67
  title effects 70
  video clips 56
Splitting clips 54
Storyboard 42
Subtitles
  add 80
  edit 81
  import 81
  overview 38
  sync 81
Support 123
Supported file formats 14
SVRT
  overview 120
  viewing in project 84
System requirements 10

T
Technical support 123
Text remark 19, 57
Time code 19, 57
Time info 57
Time limit for captures 19
Timeline
  adding media 43
  adding PiP objects 50
  adding title effects 50
  adding transition effects 51
  adding video effects 49
  fit 40
  hide tracks 41
  lock tracks 41
  overview 39
  unlock tracks 41
  view 39
  zoom 41
Title effects
  adding to timeline 50
  animations 70, 71
  download 16
  modifying font 69
  overview 37
  save 71
  shadows 69, 70
  share 71
  speed 70
Title track
  adding titles 50
  description 40
Track manager 40
Tracks
  descriptions 40
  hide 41
lock 41
manage 40
unlock 41
Transition effects
   adding random 51
   adding to timeline 51
Transitions, overview 38
Transparency of PiP effects 65
Trim, audio & video clips 54
TV, capturing 21

U
Unlock track 41
Update SVRT Info 84
Upgrade 4
Upload
   disc menu template 105
   PiP template 68
   title templates 71
   video to YouTube 95

V
Video
   adding to workspace 47
   disc qualities 107
   Magic Fix 61
   Magic Style 61
   menu thumbnail 107
   overlay 29
   preview 52
   profiles 89
   speed 56
   split 54
   split audio 73
   trimming 54
   Video clip
      detecting scenes in 23
      extract audio 24
   Video effects
      add to entire clip 49
      adding to timeline 49
      disc menu 105
      modifying 63
   Video track
      adding color boards 48
      adding media 47
      adding transitions 51
      description 40
   Voice track
      adding audio 48
      description 40
   Voice-over recording 76
   Voice-over recording room 38
   Volume
      adding keys 74
      changing in-track 74

W
Webcam, capturing 22
Workspace
   adding clips to 47
   adding effects to 49
   adding titles to 49
   adding transitions to 49
   storyboard view 42
   timeline view 39
Write back to
DV tape 93
HDV tape 93